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Commands and dialog boxes
 Shortcut keys
 Xchange Agent commands

Choose commands with the menu bar, LinkBar, File Transfer icons, and shortcut keys. All commands are 
accessible through the menus. Many commands have keyboard and Toolbar equivalents. Some commands and 
menus are available for any service, and some are available only with specific services, such as Remote Control, 
File Transfer, or Chat.

A

About LapLink for Windows 95

About Xchange Agent

Add, Edit, and Copy Address Book Entry dialog boxes

Add, Edit, and Copy Log-in List dialog box

Add Filter dialog box (Xchange Agent)

Add Folder Pair (Xchange Agent)

Address Book

Arrange Icons (File Transfer only)

Arrange Icons (Window menu)



B

Blank Host Screen (Remote Control only)

C

Cable (Serial) Port Setup dialog box

Callback Request dialog box

Cascade

Change Password dialog box

Chat

Chat Options

Choose a connection dialog box (Xchange Agent)

Choose folders to synchronize dialog box (Xchange Agent)

Clear Selection (File Transfer only)

Clone Folder

Close

Close All

Close (Xchange Agent only)

Close Preview (Xchange Agent)

Computer Name

Connect Options

Connect over Cable

Connect over Dial-Up Networking

Connect over Modem

Connect over Modem dialog box

Connect over Network

Connect over Wireless

Control menu

Copy (Chat only)

Copy (File Transfer only)

Copy Address Book Entry dialog box

Copy Log-in List dialog box

Create Desktop Shortcut (Xchange Agent)

Create Short File Names dialog box

Cut (Chat only)

D

Delete (File Transfer only)

Delete Pair(s) (Xchange Agent)

Detail (File Transfer only)

Dialing Status dialog box



Disconnect

E

Edit Address Book Entry dialog box

Edit Log-in List dialog box

Exit

F

File Status Line (File Transfer only)

File Transfer Options

Filter (File Transfer only)

Full Screen (Remote Control only)

G

H

Hang Up Modem

Help Topics

I

IPX (Network) Port Setup dialog box

J, K

L

Large Icons (File Transfer only)

Left to Right Only (Xchange Agent)

LinkBar

List (File Transfer only)

Local Security Password dialog box

Lock Host Keyboard (Remote Control only)

Lock Host Mouse (Remote Control only)

Log-in List dialog boxes

Log-in Name and Password dialog box

Logging

M

Make Folder (File Transfer only)

Maximize

Minimize

Modem Customization dialog box

Modem Setup dialog box

Move

Move (File Transfer only)

N



Network (IPX) Port Setup dialog box

New Xchange Agent

Next Conflict (Xchange Agent)

O

Open Chat

Open File Transfer

Open Local File Window

Open Remote Control

Open Xchange Agent

P

Parallel Port Setup dialog box

Paste (Chat only)

Port Setup

Preview Xchange Agent

Properties (Xchange Agent)

Properties for New Agents (Xchange Agent)

Protected Files dialog box

Q

Quick Steps

R

Reboot Host

Refresh

Remote Control

Remote Control Options

Remote Control Performance Options

Rename (File Transfer only)

Resolve Conflict (Xchange Agent)

Resolve File Conflict dialog box (Xchange Agent)

Resolve Folder Conflict dialog box (Xchange Agent)

Resolve LFN Conflict dialog box (Xchange Agent)

Restore

Restore Connections

Right to Left Only (Xchange Agent)

Run Xchange Agent

S

Save Connections

Save Xchange Agent

Save Xchange Agent As



Scale to Fit (Remote Control only)

Schedule (Xchange Agent)

Security

Select All (Chat only)

Select All (File Transfer only)

Select All (Xchange Agent only)

Select By (File Transfer only)

Select Modem dialog box

Serial (Cable) Port Setup dialog box

Set Filter (Xchange Agent)

Size

Size of Selections (File Transfer only)

Skip Pair(s) (Xchange Agent)

Small Icons (File Transfer only)

SmartXchange

SpeedSync Statistics

Status Line

Status Line (File Transfer only)

Status Line (Xchange Agent only)

Synchronize Both Directions (Xchange Agent)

T

Tile Side by Side

Tile Vertically

Toolbar

Toolbar (Xchange Agent)

U

Undo

Undo Skip Pair(s) (Xchange Agent)

User Name and Password (Dial-Up Networking) dialog box

V

W

Window List

Windows 95 Modem Configuration dialog box

Wireless Port Setup dialog box

X, Y, Z

Xchange Agent Wizard



Address Book command
 Quick Steps
 Related Topics
 Tips

Displays the Address Book, where you can create and edit entries for computers you frequently connect to. 
Creating Address Book entries simplifies the process of connecting to a remote computer.

In each entry you can specify:

The kinds of services (File Transfer, Remote Control, and Chat) to be opened automatically when you 
connect

Any security information required by the remote computer
For modems, a telephone number
For TCP/IP, an IP name or address

Option Description

Remote 
Computers

Lists the remote computers you have added to your Address Book.

Computer Specifies the name and phone number of the remote computer selected in the 
Remote Computers list.

Services Specifies which services File Transfer, Remote Control, and Chat open when 
connecting to the remote computer selected in the Remote Computers list.

Close Click this to close this dialog box and save any changes you made.

Add Click this to specify connection information for another computer.

Edit Click this to change connection information for the computer selected in the Remote 
Computers list.

Copy Click this to save the selected remote computer in your Address Book using a 
different name.

Hint:    Use this button when you want to specify another method of connecting to 
the same computer.

Delete Click this to remove the selected remote computer from your Address Book.

Help Click this to display an overview of this dialog box.

Add, Edit, and Copy Address Book Entry dialog boxes
 Quick Steps
 Related Topics
 Tips

These dialog boxes contain the same fields, except when the connection is by modem or TCP/IP. If you choose 
modem, you must specify phone-related information. If you choose TCP/IP network, you must specify address 
information.

If you chose Add in the Address Book dialog, the fields are empty. If you chose Edit or Copy, the fields are filled in.

Option Description

Description Type your own description of the computer, connection, or settings. This 
description is shown in the Remote Computers list and does not have to match 
any information on the remote computer.

Computer Name Type the name of the remote computer. This name must match the name that 
is entered in the remote computer’s Computer Name dialog box.



Connection Type Lists the available connection types.

If you choose Modem, type the remote computer’s telephone number. If you 
choose Network: TCP/IP, type the remote computer’s TCP/IP name or 
address.

If you use different methods to connect to a remote computer, add an Address 
Book entry for each connection type for this computer. Use the description to 
label these different types of settings.

Area Code Type the remote computer's area code.

You must first click Use country and area code so that it is checked.

This option is available only if you selected Modem in the Connection Type list.

Phone Number Type the remote computer's modem phone number.

To specify the area code or country code, make sure that Use country and 
area code is checked.

This option is available only if you selected Modem in the Connection Type list.

Country Code Lists countries and their country codes, which are dialed before the area code. 
Also specifies the selected country code.

To change the country code, click the country in the list. You must first click 
Use country and area code so that it is checked.

This option is available only if you selected Modem in the Connection Type list.

Use country code 
and area code 

If checked, the area code and country code, if applicable, will be dialed. If 
cleared, you cannot specify the area code or country code.

This option is available only if you selected Modem in the Connection Type list.

TCP/IP Address Type the TCP/IP address for the computer you want to connect to.

This is the computer’s Internet address, which can be a string of numbers like 
this: 255.255.255.255, or a descriptive network name like this: 
janedoe.acme.com. The descriptive address is often similar to the email 
address, but does not include @.

This option is available only if you selected Network: TCP/IP in the Connection 
Type list.

Services Specifies which services File Transfer, Remote Control, and Chat open 
when connecting to the selected computer.

Screen Blank If checked, the host computer’s screen turns black when you connect and 
open a remote control session.

Mouse Disable If checked, the host computer cannot use its mouse when you connect and 
open a remote control session.

Keyboard 
Disable

If checked, the host computer cannot use its keyboard when you connect and 
open a remote control session.

Note: The host computer must first grant you this privilege by clicking Security 
on the Options menu.

Log-in Name Type the log-in name assigned to you in the remote computer’s Log-in list. If 
unsure, contact the owner of the remote computer.

Password Type the password assigned to you in the remote computer’s Log-in list. If 



unsure, contact the owner of the remote computer.

OK Click this to close this dialog box and save any changes you made.

The entry appears in the Address Book's Remote Computers list under the 
name you specified in the Description field.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Add, Edit, and Copy Log-in List Entry dialog boxes
 Quick Steps
 Related Topics
 Tips

These dialog boxes contain the same fields. If you chose Add, the fields are empty. If you chose Edit or Copy, the 
fields are filled in.

Option Description

Log-in Name Type the name that the user must provide to connect to this computer and 
open services.

This name should be in the remote computer's Address Book. If not, the 
remote user will be asked to type this name when connecting.

Password Type the password for this user.

This password should be in the remote computer's Address Book. If not, the 
remote user will be asked to type this password when connecting.

Services Specifies which services File Transfer, Remote Control, and Chat the 
remote user can open when connecting.

Blank Screen Click this to allow guests to blank the screen of this computer.

Disable Mouse Click this to allow guests to disable this computer’s mouse.

Disable Keyboard Click this to allow guests to disable this computer’s keyboard.

The remote computer will also need to specify locking in the Address Book, 
or request it during the Remote Control session.

Modem Callback Specifies whether, or how, the user will be called back when opening a 
connection:

Click None if no callback is allowed or required for this user.

Click Optional, Any Number to allow callbacks to the remote 
computer's modem at any number provided by the caller.

Click Optional, Specified Number Only to allow callbacks to the 
remote computer's modem at the number specified in the Phone Number 
box. You also need to type the phone number in the Phone Number box.

Click Required, Any Number to force callbacks to the remote 
computer's modem at any number. The remote user can change or enter a 
number during connection.

Click Required, Specified Number Only to force callbacks to the 
remote computer's modem at the number specified in the Phone Number 
box. You also need to type the phone number in the Phone Number box.

Phone Number Type a phone number that your modem will dial when calling back a 
connection.

If you clicked Optional, Specified Number Only or Required, Specified 



Number Only, this phone number is dialed.

OK Click this to close this dialog box and save any changes you made.

The entry appears in the Log-in list under the name you specified in the Log-
in Name field.

Cancel Click this to close this dialog box without saving any changes you made.

Defaults Click this to restore the original settings.

Help Click this to display an overview of this dialog box.

Cable (Serial) Port Setup dialog box
 Quick Steps
 Related Topics
 Tips

For LapLink cable and wireless connections, enabling a serial port is usually sufficient. On certain computers, 
however, the default settings may have to be changed before a connection can be made.

These are the two most common reasons for changing the initial settings: to eliminate a conflict between two ports 
and to lower the port speed.

Hint: If you are having a problem connecting over a serial port, click Related Topics and then click a 
Troubleshooting topic.

Option Description

Port Speed Specifies the speed selected for the current port, and lists available port speeds.

In most cases, set this at 115,200. Try lower speeds if you have problems 
connecting.

Transfer Mode Specifies how efficiently LapLink uses the selected port:

Click Enhanced to allow LapLink to communicate in an accelerated (7-
wire) mode.

Click Standard to force LapLink to communicate in the standard (3-wire) 
mode. Select this option if you are using an older serial port or you are using a 3-
wire LapLink-compatible cable.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Defaults Click this to restore the original settings for the selected port.

Help Click this to display an overview of this dialog box.

Callback Request dialog box
 Quick Steps
 Related Topics
 Tips

The remote computer is either requiring a callback to your computer or asking whether a callback should occur 
before the connection is opened. Depending on the security setup of the remote computer, you can specify the 
number to be called back or you must accept the number appearing in this dialog box.

Callback protection is set up by clicking Security on the Options menu.

Option Description

Phone Number Specifies the phone number that the modem will redial.



Be sure to include any prefix or suffix you want dialed with the number. The remote 
computer’s settings in Windows 95 Dialing Properties are not used for callbacks.

Yes Click this to redial the specified phone number.

No Click this to close the attempted connection without redialing the specified phone 
number.

Cancel Click this to close this dialog box without opening the connection.

Help Click this to display an overview of this dialog box.

Change Password dialog box
 Quick Steps
 Related Topics
 Tips

Type the new password twice, and then click OK. If the two password entries match, the new password is 
accepted. If not, type them again to ensure that there is a match.

Option Description

New Password Type a new password for accessing commands that require password protection.    
Commands that require local password protection include Security, Address Book, 
Connect over Modem, Connect over Network, Remote Control Host Options, and 
Logging.

Confirm New 
Password

Type the new password again, exactly as entered in New Password.

Your password appears as asterisks to keep it confidential.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Clone Folder command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Deletes the contents of the target folder and replaces it with the contents of the source folder.

Source files replace older existing target files, and new source files are added to the target folder. Files that exist 
in the target folder but not in the source folder are deleted from the target folder.

Caution:    The Clone Folder command may delete files from the target folder.

Option Description

From Lists the source computer and folder, which is the folder currently selected in the 
tree (left) pane. Clone Folder does not delete or update files in this folder.

Source files replace older existing target files, and new source files are added to the 
target folder. Files that exist in the target folder but not in the source folder are 
deleted from the target folder.

Computer Specifies the name of the target computer, and lists available computers.

To choose another target computer, click its name from the list.

Folder Specifies the target drive and folder. Type the target drive and folder, if you need to 



change the selection. This folder and its files will be updated so that it is identical to 
the source folder on the source computer.

Include 
Subfolders

If checked, subfolders in the source folder are copied to the target folder. If cleared, 
only files in the source folder are copied.

As with files, subfolders that exist in the target folder but not in the source folder are 
deleted from the target folder.

OK Click this to create an exact copy of the selected folder in the target folder.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Computer Name command
 Quick Steps
 Related Topics
 Tips

Changes the name by which LapLink identifies your computer on remote computers as well as locally.

Option Description

Computer Name Type the name of your computer.    This is the name LapLink uses when identifying 
your computer to remote computers. If on a network, making this name different 
from other computers on the same network makes it easier for identification.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Connect Options command
 Quick Steps
 Related Topics
 Tips

Set options to determine whether and how connections are opened when you start LapLink. Other options let you 
turn off the sounds issued when a remote computer opens or closes a service to your computer, and break 
connections after a period of inactivity.

To set options for automatic connections, click the Startup tab. To set options for connecting, click the Connect 
tab. To set options for disconnecting, click the Disconnect tab.

Tab Option Description

Startup tab Restore saved 
connections at 
startup

If checked, LapLink will restore the connections specified 
in the selected file when you start LapLink. In the 
Connection File box, specify the connection file.

Connection File Shows the specified connection file. Connection files are 
saved in the \tsi32\data folder, which is located where 
Windows 95 was installed. To find a connection file in 
another location, click Browse.

If Restore saved connections at startup is checked, 
LapLink will attempt to connect to the computers 
specified in this connection file when you start LapLink.

Browse Click this to locate and select the connection file.



Restore 
Connection 
Prompt

If Restore saved connections at startup is checked, 
select an option for connecting:

Click Automatically Connect at Startup if you 
want your saved connections automatically restored 
when you start the program without asking first.

Click Ask Before Connecting if you want to be 
asked when you start the program whether you want to 
restore your saved connections.

Connect tab Enable Cable or 
Wireless 
Autoconnect

If checked, the connection is made automatically when 
the cables or wireless devices are plugged in.

Then, specify which services File Transfer, Remote 
Control, and Chat open when you connect to another 
computer.

Beep for If checked, a series of tones sound whenever a remote 
computer opens or closes a service to your computer. 

Then, specify which services File Transfer, Remote 
Control, and Chat will prompt the sounds.

Disconnect 
tab

Disconnect 
Inactive 
Connections

If checked, a connection either incoming or outgoing
is broken after a period in which there is no activity at 
either end of the connection. In the box below, type the 
number of minutes for the inactivity period.

After minutes Type the number of minutes of inactivity allowed at either 
computer before the connection is broken.

Defaults Click this to close this dialog box and save any changes 
you made.

OK Click this to restore the original settings.

Cancel Click this to close this dialog box without saving any 
changes you made.

Apply Click this to save any changes you made without closing 
this dialog box.

Help Click this to display an overview of this dialog box.

Connect over Cable command
 Quick Steps
 Related Topics
 Tips

Connects to a computer over a serial or parallel cable. You can choose a computer from the Connection list, open 
service windows, and display the Address Book and Port Setup dialog boxes.

Option Description

Connection Lists all available computers to connect to over serial or parallel cable.    Click a 
computer name that is in the Address Book, and settings from the Address Book 
appear under Services. You can change these settings without affecting the entry in 
the Address Book.

Services Specifies which services File Transfer, Remote Control, and Chat you want to 
open when connecting to the selected computer.    LapLink opens one Chat, two File 
Transfer, and one Remote Control windows.

OK Click this to connect to the selected computer.



Cancel Click this to close this dialog box without saving any changes you made.

Address Book Click this to open the Address Book.

Port Setup Click this to change port settings, to enable and disable ports, or to change your 
modem type.

Help Click this to display an overview of this dialog box.

Connect over Modem command
 Quick Steps
 Related Topics
 Tips

Connects to a computer over a modem. You can choose a computer from the Connection list, open service 
windows, enter the modem number to dial, and display the Address Book and Port Setup dialog boxes.

Option Description

Connection Lists all available computers to connect to over a modem.    Click a computer name, 
and its phone number appears. If the computer name is not in the Address Book, 
click Manual Dial, and then type the phone number.

Phone Number Displays the phone number of the selected computer.    If you clicked Manual Dial, 
type the phone number of the remote computer.

Dialing Location Lists the available dialing locations, and specifies which dialing location you will use 
for this connection.

To change the selected dialing location, click another dialing location in the list.

You can add or change dialing location settings by clicking Dial Properties.

Dial Properties Click this to change settings for dialing from this location or to add a new dialing 
location.

Connect Using Lists the available modems, and specifies the modem you will connect over.

To change the selected modem, click another modem in the list.

To use a modem not listed, click Port Setup to install it.

Services Specifies which services File Transfer, Remote Control, and Chat you want to 
open when connecting to the selected computer.    LapLink opens one Chat, two File 
Transfer, and one Remote Control windows.

Dial Click this to dial the phone number and connect to the selected computer.

Cancel Click this to close this dialog box without saving any changes you made.

Address Book Click this to open the Address Book.

Port Setup Click this to change port settings, to enable and disable ports, or to change your 
modem type.

Help Click this to display an overview of this dialog box.

Connect over Modem dialog box
 Quick Steps
 Related Topics
 Tips

Opens if you are already connected over a modem, and allows you to decide what modem you want to use to 
connect. You must have two modems installed for this dialog box to open.



Option Description

Open another 
window for the 
existing connection

Click this to retain your existing connection to the remote computer, and to open 
new service windows as you selected in the previous Connect over Modem dialog 
box.

Dial and connect 
over a different 
modem

Click this to retain your existing connection to the remote computer, and use 
another modem to connect to the selected remote computer.

OK Click this to connect to the selected computer as specified.

Cancel Click this to close this dialog box without connecting over modem.

Help Click this to display an overview of this dialog box.

Connect over Network command
 Quick Steps
 Related Topics
 Tips

Connects to a computer over a network. You can choose a computer from the Connection list, open service 
windows, and display the Address Book and Port Setup dialog boxes.

Option Description

Available Now tab Lists all available computers to connect to over network.

Click a computer name that is in the Address Book, and settings from the Address 
Book appear under Services. You can change these settings without changing the 
entry in the Address Book.

If a computer name is not listed on the Available Now tab, click the TCP/IP 
Addresses tab and enter the computer’s TCP/IP Address.

TCP/IP Addresses 
tab

Lists all computers that you have in your Address Book for connecting over 
TCP/IP network. Click a computer name that is in the Address Book, and settings 
from the Address Book appear under Services. You can change these settings 
without changing the entry in the Address Book.

To connect to a computer not listed, click Manual Connect and then type the 
computer’s TCP/IP Address.

TCP/IP Name or 
Address

Type the TCP/IP address for the computer you want to connect to.

This is the computer’s Internet address, which can be a string of numbers like this: 
255.255.255.255, or a descriptive network name like this: janedoe.acme.com. The 
descriptive address is often similar to the email address, but does not include @.

Services Specifies which services File Transfer, Remote Control, and Chat you want to 
open when connecting to the selected computer.    LapLink opens one Chat, two 
File Transfer, and one Remote Control windows.

OK Click this to connect to the selected computer.

Cancel Click this to close this dialog box without saving any changes you made.

Refresh List Click this to update the list of available computers shown in the Computers list.

Address Book Click this to open the Address Book.

Port Setup Click this to change port settings, to enable and disable ports, or to change your 
modem type.

Help Click this to display an overview of this dialog box.



Connect over Wireless command
 Quick Steps
 Related Topics
 Tips

Connects to a computer over a wireless device. You can choose a computer from the Connection list, open 
service windows, and display the Address Book and Port Setup dialog boxes.

Option Description

Connection Lists all available computers to connect to over wireless.    Click a computer name 
that is in the Address Book, and settings from the Address Book appear under 
Services. You can change these settings without affecting the entry in the Address 
Book.

Services Specifies which services File Transfer, Remote Control, and Chat you want to 
open when connecting.    LapLink opens one Chat, two File Transfer, and one 
Remote Control windows.

OK Click this to connect to the selected computer.

Cancel Click this to close this dialog box without saving any changes you made.

Address Book Click this to open the Address Book.

Port Setup Click this to change port settings, to enable and disable ports, or to change your 
modem type.

Help Click this to display an overview of this dialog box.

Disconnect command
 Quick Steps
 Related Topics
 Tips

Disconnects from one or more computers that you are connected to. When you disconnect, all service windows 
for that connection are closed.

Option Description

Connections Lists the active connections.    When you disconnect, all service windows for that 
connection are closed.

OK Click this to disconnect the selected computer.

Cancel Click this to close this dialog box without saving any changes you made.

Disconnect All Click this to disconnect all computers in the Connections list.

Help Click this to display an overview of this dialog box.

Copy command (File Transfer only)
 Quick Steps 
 Related Topics
 Tips

Copies the selection from the source folder to the target folder. Selected files or folders can be copied between 
folders on a single computer, between a local and a remote computer, or between two remote computers.

Option Description



From Specifies the name of the source computer and the source folder, as selected in the 
File Transfer window.

Computer Specifies the name of the target computer as selected in the File Transfer window
and lists available computers. To choose another target computer, click its name 

from the list.

Folder Specifies where the selected files and folders will be copied, as selected in the File 
Transfer window.    To change the target folder, type the drive and folder names.

Transfer only if 
files are newer

If checked, the selected files are copied only if the date and time are newer than the 
matching file on the target.    Files not in the target folder are also copied. To avoid 
these copies, click Transfer only if files are already on target.

Transfer only if 
files are already 
on target

If checked, the selected files are copied only if the file already exists on the target.

Include 
subfolders

If checked, subfolders of the selected folder are copied.

Show statistics 
when complete 

If checked, the following information is displayed after the transfer:    name of 
computer and path where files are transferred from, name of computer and path 
where files are transferred to, number of files selected, number of files copied, 
number of files not copied, number of bytes transferred, and number of files not 
transferred due to options selected when copying.

OK Click this to copy the selection.

Cancel Click this to close this dialog box without copying the selection.

Help Click this to display an overview of this dialog box.

Delete command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Deletes the selected file or folder. Removes multiple files and folders.

Caution:

Avoid deleting any hidden system files. The computer may not start or operate properly.
Deleting a folder deletes all of its subfolders and files. Before deleting a folder, make sure that it contains no 

files you want to keep.

Option Description

Computer Name Lists the name of the source computer and the source folder.

File name Lists the name of the file that you have selected.

To delete the file, click Yes. To keep the file, click No.

Yes Click this to remove the selected file or folder.

If you have selected multiple files and folders, you are prompted for each one unless 
you click Yes to All.

Yes to All Click this to remove all selected files and folders. 

Read-only, hidden, and system files will display an additional dialog box. Click OK to 
delete these files.

No Click this to stop the displayed file or folder from being deleted. 



When more than one file is selected, clicking No bypasses only the currently 
displayed file.

Cancel Click this to cancel the deletion.

If you have already clicked Yes for other files, clicking Cancel does not recover those 
files.

Help Click this to display an overview of this dialog box.

Move command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Moves the selection from the source folder to the target folder. Selected files and folders can be moved between 
folders on a single computer, between a local and a remote computer, or between two remote computers.

Caution:    Moving removes files and folders from the source folder.

Option Description

From Lists the name of the source computer and the source folder.

Caution:    Moving removes files and folders from the source folder.

Computer Specifies the name of the target computer and lists available computers. To choose 
another target computer, select it from the list.

Folder Specifies where the selected files and folders will be moved.    To change the target 
folder, type the drive and folder.

Transfer only if 
files are newer

If checked, the selected files are moved only if the date and time are newer than the 
matching file on the target.    Files not in the target folder are also moved. To avoid 
these moves, click Transfer only if files are already on target.

Transfer only if 
files are already 
on target

If checked, the selected files are moved only if the file already exists on the target.

Include 
subfolders

If checked, all subfolders of the selected folder are moved.

Show statistics 
when complete 

If checked, the following information is displayed after the transfer: name of 
computer and path where files are transferred from, name of computer and path 
where files are transferred to, number of files selected, number of files transferred, 
number of files not transferred, number of bytes transferred, and number of files not 
transferred due to options selected when moving.

OK Click this to move the selection.

Cancel Click this to close this dialog box without moving the selection.

Help Click this to display an overview of this dialog box.

File Transfer Options command
 Quick Steps
 Related Topics
 Tips

Sets options for File Transfer operations. Options include setting confirmations for operations, setting options for 
file transfers, and displaying transfer statistics.

To set options for copying or moving files and folders, click the Copy/Move tab. To set options for deleting files and 



folders, click the Delete tab. To set filter options, click the Filter tab. To set transfer performance options, click the 
Performance tab. To set display options, click the Display tab.

Tab Option Description

Copy/Move Enable File Transfer 
Recovery

If checked, you can restart any file transfer process that is 
disconnected and the process will continue from where it 
was interrupted instead of from the start.

If cleared, any file transfer process that is restarted will 
begin from the start again.

Hint: If this option is checked, make sure that these 
options are checked: Use SpeedSync on the Performance 
tab; and Transfer only if files are newer on the Filter tab.

Before any copy or 
move operation

If checked, you must OK each time that you copy or move 
files or folders.

When a file is going 
to be overwritten

If checked, you must OK that you want to overwrite files.

When a read-only 
file is overwritten or 
deleted

If checked, you must OK that you want to overwrite or 
delete read-only files.

Delete tab Files If checked, you must OK each file before it is deleted.

Folders If checked, you must OK each folder before it is deleted.

Move deleted files 
and folders to the 
Recycle Bin

If checked, all deleted files and folders are removed from 
their original location and are placed in the Windows 
Recycle Bin. To remove the files and folders permanently, 
empty the Recycle Bin.

If cleared, files and folders are permanently removed from 
the disk when you delete them.

Filter tab Transfer only if files 
are newer

If checked, files are copied or moved from one folder to 
another only when the source file is newer. This option 
ensures that files are not overwritten by older copies.

Transfer only if files 
are already on target

If checked, files are copied or moved from one folder to 
another only when the source files are already on the 
target. Source files that do not exist on the target are not 
transferred.

Include subfolders 
in copies

If checked, subfolders in the source folder are copied to 
the target folder.

Include subfolders 
in SmartXchange

If checked, subfolders are included in any SmartXchange 
operation.

Performance 
tab

Use compression 
when transfering 
files

If checked, compresses the size of files that are 
transferred, and then decompresses the files onto the 
target folder. The target files will be the same size as the 
source files.

Use SpeedSync on 
all file transfers

If checked, SpeedSync is used for all file transfers. 
SpeedSync may dramatically improve the transfer speed 
of files by sampling and transferring only changed data 
between source and target files of the same name.

Note: SpeedSync is a tool for decreasing transfer times. It 
does not merge the contents of two files. The contents of 



one file will always replace the contents of another. If you 
want to merge databases, schedules, or other shared 
files, see the documentation for the application in which 
they were created.

Display tab New windows tiled 
side by side

If checked, new File Transfer windows appear side by 
side when opened.

If cleared, new File Transfer windows appear one above 
the other.

Show statistics 
when complete

If checked, File Transfer statistics are displayed after 
copying or moving files.

Defaults Click this to restore the original settings.

OK Click this to close this dialog box and save any changes 
you made.

Cancel Click this to close this dialog box without saving any 
changes you made.

Apply Click this to save any changes you made without closing 
this dialog box.

Help Click this to display an overview of this dialog box.

Filter command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays a filtered set of file and folder information in the active file pane. You can filter by file name, extension, 
hidden/system files, and date and time range. When you copy, move, or delete a folder, you include every file in 
the folder, regardless of the filter setting.

Caution: Proceed carefully when hidden and system files are displayed. Deleting or moving certain files in the 
root folder may cause the computer to work improperly or not at all.

Option Description

Computer Specifies the name of the active computer.

Folder Specifies the name of the current folder.

Filter Type the criteria for files you want displayed in the active file pane.

You can use wildcards (for example:    win?.*,    *.exe, *.ini), or an entire file name 
(win.ini). You can specify several criteria by inserting a space or a comma 
between them. The default is *, which displays all files.

Hint: In Windows 95, file name extensions are associated with file types. For 
example, doc generally specifies a Microsoft Word document.

Show Subfolders If checked, all subfolders are displayed according to the specified filter.

Show 
Hidden/System 
Files

If checked, all hidden and system files are displayed according to the specified 
filter.

Caution: When hidden and system files are displayed, deleting or moving these 
files may cause the computer to work improperly or not at all.

Enable Date/Time 
Range

If checked, only files that fall within a specified date and time range are displayed. 
You can then type dates and times in the Oldest File and Newest File boxes.



Oldest File Type the date and time of the oldest file that you want displayed.    The date format 
is mm/dd/yy, and the time format is hh:mm am or pm.

Newest File Type the date and time of the newest file that you want displayed. The date format 
is mm/dd/yy, and the time format is hh:mm am or pm.

OK Click this to update the view of the file pane for the current File Transfer window 
according to the filter information.

Cancel Click this to close this dialog box without saving any changes you made.

Default Click this to restore the original settings.

    Help Click this to display an overview of this dialog box.

Network (IPX) Port Setup dialog box
 Quick Steps
 Related Topics
 Tips

In order to connect over an IPX network, you must have the network drivers loaded and your IPX port enabled. 
When you turn network broadcasting on, other LapLink users connected to the same network can see your 
computer and connect to it.

Hint: If you are having a problem connecting over a network port, click Related Topics and then click a 
Troubleshooting topic.

Option Description

Enable If checked, your computer name is broadcast to all servers on the IPX 
network. Other LapLink users connected to the same network can see your 
computer name in the Connect over Network dialog box, and can connect to 
your computer. 

If cleared, your computer name is not broadcast to other servers on the IPX 
network. Only LapLink users on your local subnet can see your computer 
name in the Connect over Network dialog box.

OK Click this to close this dialog box and save any changes you made.

Help Click this to display an overview of this dialog box.

Local Security Password dialog box
 Quick Steps
 Related Topics
 Tips

You have chosen a command with password protection. Type the password and then click OK.

Local password protection is set up using the Security command on the Options menu.
When local security is in effect, you must supply the password before you can use any commands in which 

security might be compromised. These commands include Security, Address Book, Connect over Modem, Connect 
over Network, Remote Control Host Options, and portions of Logging.

Option Description

Enter Password Type the password required to access commands for your local computer.

You can reset this password by clicking     or by clicking Security on the 
Options menu.

OK Click this to compare the typed password with the password required by the local 
security system. You can proceed if the passwords agree.



Cancel Click this to close this dialog box without logging into the local command.

Help Click this to display an overview of this dialog box.

Log-in Name and Password dialog box
 Quick Steps
 Related Topics
 Tips

Type the log-in name and the password required by the computer you are attempting to connect to.

Password protection is set up using the Security command on the Options menu.
If you intend to connect to the remote computer again, you can store the log-in name and password in an 

Address Book entry. When you attempt to connect to that computer again, the name and password will be forwarded 
automatically.

Option Description

Log-in Name Type the log-in name assigned to you on the remote computer.

Password Type the password assigned to the log-in name on the remote computer.

OK Click this to send the log-in name and password to the remote computer. The 
connection will be opened if the log-in name and password meet the security 
requirements of the remote computer.

Cancel Click this to close this dialog box without opening the connection.

Help Click this to display an overview of this dialog box.

Logging command
 Quick Steps
 Related Topics
 Tips

Enable or disable the log. By default, LapLink creates a log file every day you run LapLink. A log file can contain 
such information as who connects to your computer and when, which files are transferred, and security violations.

A log file is named like this: LLWmmdd.LOG. For example, LLW0623.LOG is the log file for June 23rd. Log files 
are stored in \TSI32\LLW in the Windows installation folder.

Option Description

Enable Logging If checked, LapLink creates a log file when you use LapLink. If cleared, all 
other options are unavailable.

Security 
Violations

If checked, any attempts to connect without the correct password or log-in 
name are recorded in the log file.

Connections and 
Disconnections

If checked, all connections and disconnections are recorded in the log file.

File Transfer 
Summary

If checked, the number of files selected and the number that are copied or 
moved are recorded in the log file. Also shows the number of files that are 
not copied because of options settings.

File Transfer 
Details

If checked, the names of files that are copied or moved are recorded in the 
log file.

Callback Numbers If checked, the numbers dialed for callbacks are recorded in the log file.

Modem Strings If checked, modem strings sent when a connection is made over modems 
are recorded in the log file.

Maximum Number Type the number of log files that are created. When the limit is reached, the 



of Log Files oldest log file is deleted to make way for the new one.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

View Log Click this to display the most recent log in Windows WordPad.

Defaults Click this to restore the original settings.

Help Click this to display an overview of this dialog box.

Create Short File Names dialog box
 Quick Steps 
 Related Topics
 Tips

LapLink requests a new file name when transferring files to a system that does not allow long file names.

Hint: Long file names are not recognized by some network servers.

Option Description

Source Path Specifies the name of the source folder, as selected in the File Transfer window.

Target Path Specifies where the selected files will be transferred to, as selected in the File 
Transfer window.

Short Name Type a new file name, using a short (DOS) file name. You are limited to eight 
characters plus a three-character extension.

OK Click this to rename the file using the new file name specified in the Short Name 
box.

Automatic Click this to automatically create short names for all selected files.

If you click this, you will not be prompted to rename any other files.

Skip Click this to proceed to the next file, without transferring the file shown.

Cancel Click this to close this dialog box without renaming or transferring the selection.

Help Click this to display an overview of this dialog box.

Make Folder command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Creates a new folder in the File Transfer window. The new folder appears as a subfolder of the selected folder or 
drive.

Option Description

Location Specifies the name of the computer and the path where the new folder will be 
placed.    The new folder appears within the selected drive or folder.

New Folder Type a name for the folder.    If the host computer is running Windows 95, you can 
use long names supported by Windows 95. If the host computer is running Windows 
3.1, you are limited to eight characters (plus a three-character extension).

OK Click this to create the folder.

Cancel Click this to close this dialog box without saving any changes you made.



Help Click this to display an overview of this dialog box.

Modem Customization dialog box
 Quick Steps
 Related Topics
 Tips

You can customize the way your modem operates by choosing new setting and response strings for the modem. 
Unless you are using a modem that does not appear in the list of LapLink-supported modems, you should not 
have to change any of the settings described below.

Hint: For more information, click Related Topics and then click a Troubleshooting topic.

Option Description

Modem Name Specifies the manufacturer and model of the selected modem.    If you are adding a 
new modem name, click New and type a descriptive name for the modem. This 
description is for your information, so it does not have to match the existing modem 
name.

Initialization Type the commands to initialize your modem. LapLink expects an initialization string 
to include the following: carrier detect, DTR tracking, hardware flow control (for 
high-speed modems), and locked DTE rate.    Consult the modem’s documentation 
for information on these settings.

Dial Type the commands to prepare the modem to dial. There is no need to specify tone 
or pulse settings because these values are set by the Tone Dial option in the 
Modem Setup dialog box.    Consult the modem’s documentation for information on 
these settings.

Dial Suffix Type the commands to send the numbers to the modem and direct the modem to 
dial. The standard command is ^M.    Consult the modem’s documentation for 
information on these settings.

Reset Type the command to reset your modem so that it is ready to dial or receive a call.    
Consult the modem’s documentation for information on these settings.

Auto Answer Type the command to set the number of rings before your modem answers. If you 
change this setting, you override the Answer Rings setting in the Modem Setup 
dialog box.    Consult the modem’s documentation for information on these settings.

Hang Up Type the commands to instruct your modem to hang up when you click Hang Up 
Modem from the Connect menu.    Consult the modem’s documentation for 
information on these settings.

OK Type what the modem sends and displays in LapLink when it receives an OK from 
the other modem. The standard setting is OK.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

Error Type what the modem sends and displays in LapLink when it doesn't receive a 
positive response. The standard setting is ERROR.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

No Dial Tone Type what the modem sends and displays in LapLink when it doesn't see a dial 
tone. The standard setting is NO DIAL TONE.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

No Carrier Type what the modem sends and displays in LapLink when it doesn't detect a 



carrier signal from the remote modem. The standard setting is NO CARRIER.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

Ringing Type what the modem sends and displays in LapLink when dialing out. The 
standard setting is RINGING.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

Busy Type what the modem sends and displays in LapLink when dialing a number that is 
busy. The standard setting is BUSY.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

No Answer Type what the modem sends and displays in LapLink when the remote modem 
does not answer. The standard setting is NO ANSWER.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

Connect Type what the modem sends and displays in LapLink when it connects to a remote 
modem. The standard setting is CONNECT XXXXX, where XXXXX represents the 
carrier speed.

Caution: Change response strings only if your modem’s documentation specifies 
different settings. Enter words rather than numbers.

Modem Response 
Timeout

Type the time (in seconds) that your modem should wait to establish a connection 
after dialing.    Consult the modem’s documentation for information on these 
settings.

OK Click this to close this dialog box and save any changes you made.

The entry appears in the Modem Type list under the name you specified in the 
Modem Name field. All custom modem strings are appended to the end of the list.

Cancel Click this to close this dialog box without saving any changes you made.

New Click this to set the Modem Name to User-defined Modem using the settings for the 
modem selected in the previous dialog box.

Defaults Click this to restore original settings.

Help Click this to display an overview of this dialog box.

Dialing Status dialog box
 Quick Steps
 Related Topics
 Tips

Displays the dialing information while the modem attempts to connect to the remote computer.

Option Description

Phone Number Displays the phone number that the modem is dialing.

Status Displays the current action: for example, "Dialing."

If the connection fails, a message appears. For help in solving the problem, click this 
    to open the Modem Connection Troubleshooter.

Dial Attempts Displays the number of times LapLink has attempted communication.



Redial Delay Displays the user-defined amount of time requested between dialing attempts. This 
option is set in the Modem Port Setup dialog box.

Current Call Displays the amount of time taken by the current or last call, if the attempt was 
canceled.

Total Displays the amount of time taken for overall dialing attempt.

Retry Click this to retry a busy connection.

Cancel Click this to stop the connection, and close the dialog box.

Hang Up Click this to stop the connection and reset the modem port.

Help Click this to display an overview of this dialog box.

Modem Setup dialog box
 Quick Steps
 Related Topics
 Tips

In most cases, the best way to set up modems is to enable Windows 95 Modems in the Port Setup dialog box. If 
you experience problems with that method, enable the COM port that the modem is attached to. In this dialog box, 
choose your modem in the Modem Type list and, if necessary, change default settings to fine tune the way in 
which your modem and LapLink work together.

Hint: If you are having a problem connecting over a modem, click Related Topics and then click a Troubleshooting 
topic.

Option Description

Auto-Answer If checked, incoming calls are answered automatically after the number of rings 
specified in the Answer Rings box.    If cleared, the modem will not answer incoming 
calls.

Tone Dial If checked, tone dialing is used if your telephone system supports it.    Most modern 
systems in the U.S. support tone dialing; others support pulse (rotary) dialing.

Drop DTR on 
Hang Up

If checked, the DTR (Data Terminal Ready) signal is dropped when the modem 
connection is broken.    If your modem uses the DTR signal for power or to turn itself 
on and off, clear this option so that it is not checked.

Speed Specifies the modem’s speed (baud rate) and lists available modem speeds.    
LapLink initially uses a conservative setting, usually 19,200 baud. If you have a 
faster modem, try faster speeds. For example, a 14,400 baud modem with 
compression may be able to operate at 57,600. If you have trouble connecting, try a 
lower speed.

Answer Rings Type the number of times the phone rings before the modem picks up the call.

Dial Timeout Type the time (in seconds) LapLink should wait to establish a connection after 
dialing.

Hint: If the remote computer takes a long time to answer your call and connect, 
increase this number.

Callback Delay Type the time (in seconds) that LapLink will wait before calling back another 
computer. This time is used only when the remote computer is requesting a 
callback. 

Hint: Increase this value if the modem on the other computer takes a long time to 
reset itself.

Redial Attempts Type the maximum number of times LapLink will redial a number if the first attempt 



fails.

Redial Delay Type the time (in seconds) LapLink should wait after a connection has failed before 
redialing the modem.

Modem Type Lists the available modem models.    If you don't see your modem listed, select 
another modem from the same manufacturer having the same baud rate (speed). If 
you're not sure what type you have, choose a modem similar to yours or choose a 
Hayes-compatible model.

Customize Click this to change settings for the selected modem model.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Defaults Click this to restore the original settings for the selected modem model.

 Help Click this to display an overview of this dialog box.

Parallel Port Setup dialog box
 Quick Steps
 Related Topics
 Tips

In order to connect over a parallel port, you must have an LPT port enabled. When you enable the port and 
connect the cable to another computer running LapLink, the Autoconnect option by default makes the connection.

Hint: If you are having a problem connecting over a parallel port, click Related Topics and then click a 
Troubleshooting topic.

Option Description

Use the Windows 
driver

Click this if you want LapLink to use the Windows 95 driver when connecting 
using the selected port. Use this driver if you’re using DirectParallel 
Universal cables on an ECP port.

If you’re connecting to a computer running LapLink 6.0b, LapLink should 
automatically switch to using one of the LapLink drivers.

Hint: If you are having problems connecting, try using one of the LapLink 
drivers, and then attempt to connect.

Use the LapLink 
enhanced driver

Click this if you want LapLink to use the LapLink enhanced 8-bit driver 
instead of the Windows 95 driver when connecting using the selected port.

Hint: If you are having problems connecting, try clicking Use the LapLink 
standard driver, and then attempt to connect.

Use the LapLink 
standard driver

Click this if you want LapLink to use the LapLink standard 4-bit driver 
instead of the Windows 95 driver when connecting using the selected port.

Hint: Try using this driver if you are having problems connecting.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close the dialog box without saving any changes you made.

Default Click this to restore the original settings for the selected parallel port.

Help Click this to display an overview of this dialog box.

Port Setup command
 Quick Steps



 Related Topics
 Tips

Sets up your ports for use with LapLink. In order to communicate over a port, you must first enable it for LapLink 
communications. There are several types of ports available: serial (COM), parallel (LPT), and network (IPX and 
TCP/IP). Serial ports are used for cable, modem, or wireless connections.

If you are setting up a modem, unless necessary, use the Windows 95 modem setup so that other applications 
can use the modem. Click here     for information about choosing between Windows 95 Modems and COM 
ports.

Hint: If you are having a problem connecting, click Related Topics and then click a Troubleshooting topic.

Option Description

Port Settings Lists the available ports for which LapLink for Windows has available drivers.

To change the type and port status, click the port name and then change settings 
under Type and Enable Port.

Type Specifies the type of the selected port, and lists available port types.

To change the selected type, click another type in the Type list.

LapLink port 
status

Displays the current status in LapLink for the port: Enabled, Disabled, Unavailable, 
Enabled, or Connected. If the port type is Mouse, LapLink cannot use the port.

Enable Port If checked, the port is available for use with LapLink.    If the check box is unavailable 
(grayed), the selected port is either configured for a mouse, the port status is 
unavailable, or the port is being used for a connection. 

Current Port 
Status

Lists the status of the selected port, including the transfer mode, address, IRQ, and 
any active connections.

Close Click this to close this dialog box and save any changes you made.

Configure Click this to change settings for the selected port.

Help Click this to display an overview of this dialog box.

Protected Files dialog box
 Quick Steps
 Related Topics
 Tips

Lists the names of the protected files and the reasons they have not been copied or move. Select the files you 
want transferred, or close the dialog box without affecting the files.

Caution: If you move a system file, the file is deleted from the original location and your computer may not start or 
work properly.

Option Description

Source Files 
Excluded from 
Operation

Lists the protected files, and the reasons they have not been copied or moved.    
Select the files you want transferred, or close the dialog box without affecting the 
files.

OK Click this to transfer the selected files. None of the unselected files are affected.

Cancel Click this to close this dialog box without transferring any of the protected files.

Help Click this to display an overview of this dialog box.

Remote Control Options command
 Quick Steps



 Related Topics
 Tips

Sets options for your computer when it is a Remote Control guest or host.

To set guest options, click the Guest tab. To set host options, click the Host tab. To set options that affect Remote 
Control performance, click the Performance tab.

Tab Option Description

Guest tab Send to host Click this if you want the Windows system keys to be sent to 
the host (remote) computer.

Execute on 
guest

Click this if you want the Windows system keys executed on 
the guest (local) computer. Select this option if you intend to 
control a remote computer using the keyboard exclusively.

Full-screen 
Toggle

Type a key combination to alternate between full-screen and 
window view of the host.

You can use Alt+Ctrl+N, Alt+Shift+ N, Ctrl+Shift+N, or 
Alt+Ctrl+Shift+N where N is a number or a letter.

Scaling 
Toggle

Type a key combination to alternate between scaled-to-fit 
and normal view of the host.

You can use Alt+Ctrl+N, Alt+Shift+ N, Ctrl+Shift+N, or 
Alt+Ctrl+Shift+N where N is a number or a letter.

Always Use 
Full-screen

If checked, the host's screen appears on the guest’s screen 
in the full-screen view; that is, your screen is filled with the 
view of the host computer’s screen.

When you press the shortcut keys for Full-Screen Toggle, the 
window minimizes, becoming an icon.

Match Host to 
Guest

If checked, the host's screen changes to match the screen 
settings of the guest’s screen. This is useful when you use a 
laptop computer to connect to a desktop computer.

DOS Font Lists the available font sizes you can display on your screen 
when the host computer displays DOS full-screen.

Specifies the height and width of the selected font size.    This 
font appears when the host computer displays DOS full-
screen.

Host tab Allow guest to 
reboot on 
command

If checked, your computer can be restarted whenever a 
guest requests.

When you select this option, the Reboot Host command is 
enabled on the guest's Session menu.

Always reboot 
when guest 
disconnects

If checked, your computer restarts automatically whenever 
the guest breaks the connection.

Minimize 
LapLink when 
this computer 
is a host

If checked, LapLink minimizes to an icon when you are a 
host.

Always start 
LapLink 
before 

If checked, LapLink starts when you start Windows 95.

Allows your computer to host a Remote Control session 



Windows 95 
logon

before the login prompt appears.

Performance 
tab

Performance 
Options

Specifies the visual quality and performance of the guest’s 
view of the host computer:

Click Typical for conservative settings that balance 
visual quality and performance. 

Click Best Quality to favor visual quality over 
performance.

Click Best Performance to favor performance over 
visual quality.

Click User Customized to use your most recently 
saved custom settings. To create or change these custom 
settings, click Settings.

Settings Click this to create or change the settings used when User 
Customized is selected.

Defaults Click this to restore the original settings.

OK Click this to close this dialog box and save any changes you 
made.

Cancel Click this to close this dialog box without saving any changes 
you made.

Apply Click this to save any changes you made without closing this 
dialog box.

Help Click this to display an overview of this dialog box.

Remote Control Performance Options dialog box
 Quick Steps

 Related Topics
 Tips

Sets options for your computer when it is a Remote Control guest or host . Settings that you create in this dialog 
box apply only to User Customized in the Performance tab of the Remote Control Options dialog box. You can 
change these settings while connected to another computer, and the new settings will apply to the current Remote 
Control session.

Tab Option Description

Guest 
Display tab

Preserve all 
font shapes

If checked, fonts are sent from the host computer to your 
computer as shapes, or bitmaps. This improves how words on 
the host computer’s screen appear on your screen.

Hint: Clearing this option will speed display performance, but 
may decrease the visual quality, especially with some italic 
fonts.

Use solid 
colors

If checked, colors from the host computer appear as solid 
colors instead of dithered or patterned colors. When dithered or 
patterned, colors are shown using different patterns of dots.

Prevent 
display of 
large bitmaps

If checked, only those bitmaps that occupy a smaller area (in 
pixels) than the size specified are displayed. Drag the slider bar 
to increase or decrease the allowable bitmap size. 

If unchecked, all bitmaps are displayed.

Bitmap Color Increases or decreases the number of colors that appear on 
your computer screen when viewing the host computer. Your 



monitor’s color palette determines what you can select and 
view.

Host 
Display tab

Show 
background 
wallpaper and 
patterns

If checked, the wallpaper and patterns that usually show on the 
host computer’s screen will appear while you are connected.

If cleared, the background will temporarily disappear on the 
host. When you disconnect from the computer, the host’s 
background will reappear.

Hint: Clear this option to speed display performance.

Show window 
contents when 
dragging or 
sizing

If checked, you will see the contents of a window when 
dragging or resizing on the host computer’s screen.

Hint: Clear this option to speed display performance.

Show visible 
zoom when 
minimizing and 
restoring 
windows

If checked, you will see the movement associated with opening 
and minimizing windows on the host computer’s screen.

Hint: Clear this option to speed display performance.

Keep screen 
saver running

If checked, the screen savers that usually run on the host 
computer’s screen will continue to run and may appear while 
you are connected.

If cleared, the screen saver will not run while you are connected 
to the host computer. When you disconnect, the host’s screen 
savers will restart.

Hint: Clear this option to speed display performance.

Defaults Click this to restore the original settings.

OK Click this to close this dialog box and save any changes you 
made.

Cancel Click this to close this dialog box without saving any changes 
you made.

Apply Click this to save any changes you made without closing this 
dialog box.

Help Click this to display an overview of this dialog box.

Security command
 Quick Steps
 Related Topics
 Tips

Sets security options for incoming connections on your computer.

Until you change the default security settings after installation, other computers cannot connect to this computer 
over modems or a network.

To set general security options, click the General tab. To set local security options, click the Local Security tab. To 
create or change the Log-in List, click the Log-in List tab. To set encryption options, click the Encryption tab.

Tab Option Description

General tab Nobody (Private 
System)

Click this to prevent others from connecting to your 
computer, though you can still make outgoing connections to 



other computers.

Log-in List Only 
(Protected 
System)

Click this to allow only those users in your Log-in List to 
connect to your computer.

Anybody (Public 
System)

Click this to allow any incoming connections. Then, specify 
which services incoming connections can use: File Transfer, 
Remote Control, and Chat.

Services If you checked Anybody (Public System), specify which 
services File Transfer, Remote Control, and Chat open 
when another computer connects to this computer.

Blank Screen If checked, any guest computer is allows to turn this 
computer’s screen black when it opens a remote control 
session.

Disable Mouse If checked, any guest computer is allowed to disable this 
computer’s mouse when it opens a remote control session.

Disable Keyboard If checked, any guest computer it allowed to disable this 
computer’s keyboard when it opens a remote control 
session.

Log-in List 
tab

List Lists the available log-in names, which are the users that 
may connect to your computer.

Add Click this to add a new log-in name and its password, 
services, locking, and modem callback information.

Edit Click this to change information for the selected log-in name.

Copy Click this to save the selected log-in name under a different 
name, and change the new entry.

Delete Click this to delete the selected log-in name.

Local 
Security tab

Protect local 
security with a 
password

If checked, protects your security system by requiring a 
password before you open a dialog box in which security 
information might be compromised.

Hint: Check this if you allow other computers to control your 
computer using Remote Control. Then, they will not be able 
to change your security settings.

Set Password Click this to create or change the password to protect your 
security system.

Enforce security 
for connections

If checked, cable and wireless connections are included in 
security settings.

If cleared, these types of connections are not covered by 
security settings.

Encryption 
tab

Encrypt all data 
transmitted to the 
remote computer

If checked, all data that you transfer to the remote computer 
is encrypted. This includes files, folders, Chat messages, and 
instructions sent to the remote computer when using Remote 
Control.

If you turn Encryption on, the other computer must also be 
using LapLink for Windows 95 version 7.5. Earlier versions 
do not encrypt or decrypt data.

Encryption is recommended when connecting over the 



Internet or a WAN (wide area network).

OK Click this to close this dialog box and save any changes you 
made.

Cancel Click this to close this dialog box without saving any changes 
you made.

Apply Click this to save any changes you made without closing this 
dialog box.

Help Click this to display an overview of this dialog box.

Select By command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Selects files and folders in the active file pane according to their similarities, using DOS wildcards and date 
ranges.

Option Description

Computer Specifies the name of the active computer in the last selected File Transfer window.

Folder Specifies the name of the current folder in the last selected File Transfer window.

Filter Type the criteria for files you want displayed in the active file pane, by specifying 
their similarities in file name or extension.    You can use wildcards (for example, 
win?.*,    *.exe, *.ini), or an entire name (win.ini). You can specify several criteria by 
inserting a space or a comma between them. The default is *.*, which displays all 
files.

Hint: In Windows 95, extensions are associated with file types. For example, doc 
generally specifies a Microsoft Word document.

Enable Date/Time 
Range

If checked, only files that fall within a specified date and time range are selected.    
Type dates and times in the Oldest File and Newest File boxes.

If cleared, all dates are considered.

Oldest File Type the date and time of the oldest file you want selected.    The date format is 
mm/dd/yy, and the time format is hh:mm am or pm.

Newest File Type the date and time of the newest file you want selected.    The date format is 
mm/dd/yy, and the time format is hh:mm am or pm.

OK Click this to select files according to the specified options.

Default Click this to restore the original settings. 

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Size of Selections command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Displays the name of the computer, the files and folders selected, and the size of the selected files in the active 
file pane of the File Transfer window.

Option Description



Information Specifies information on the files selected:

Computer name where the files are selected.
Number of files selected.
Number of folders selected.
Size, in bytes, of the files and folders selected, which can be compared to 

the number of free bytes on the target.

OK Click this to close this dialog box.

Help Click this to display an overview of this dialog box.

SmartXchange command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Copies files between the source folder and target folder. Older files will be overwritten, but no files or folders are 
deleted from either folder.

You can use SmartXchange to make two folders identical through a two-way exchange of files. Or you can use it 
to update a set of archive files, without changing the source folder.

Option Description

Source Specifies the name of the source computer and folder, as selected in the File Transfer 
window.    Older files will be overwritten, but no files or folders are deleted from either 
folder.

Computer Specifies the name of the target computer as selected in the File Transfer window
and lists available computers.

Folder Specifies the target drive and folder, as selected in the File Transfer window.    Type the 
drive and folder, if you need to change the selection

Include 
Subfolders

If checked, subfolders of the source and target folder are copied.

Transfer only if 
files already on 
target

If checked, only the files already on both the source and the target are copied. This 
updates files, but does not add new ones.    If cleared, the two folders will become 
identical.

One-way 
transfer only 

If checked, files are copied from the source to the target only. This option updates the 
target without changing the source.    If cleared, the transfer is a two-way exchange 
between source and target.

OK Click this to copy files and folders according to the options.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

SpeedSync Statistics command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays statistics about File Transfer operations in which SpeedSync was in effect.

Option Description

Most Recent 
Transfer

Shows statistics about File Transfer operations for the most recent transfer using 
SpeedSync:



Size (in bytes) of the files that would be transferred without using 
SpeedSync.

Size (in bytes) of the amount actually transferred.
Savings (in bytes) of amount that did not need to be transferred.

History Shows statistics about File Transfer operations since the SpeedSync history has 
been reset:

Size (in bytes) of the files that would be transferred without using 
SpeedSync.

Size (in bytes) of the amount actually transferred.
Savings (in bytes) of amount that did not need to be transferred.

Close Click this to close this dialog box.

Reset History Click this to clear the current set of historical statistics.

Help Click this to display an overview of this dialog box.

Wireless Port Setup dialog box
 Quick Steps
 Related Topics
 Tips

For LapLink wireless connections, enabling a serial port and using the default settings is usually sufficient. On 
certain computers, however, these settings may have to be changed before a connection can be made.

These are the two most common reasons for changing settings: to eliminate a conflict between two ports and to 
lower the port speed.

Hint: If you are having a problem connecting over a serial port, click Related Topics above, and then click a 
Troubleshooting topic.

Option Description

Port Speed Specifies the speed for the selected port and lists available port speeds.

If you have an older serial port, try one of the lower speeds.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Defaults Click this to restore the original settings for the selected port.

Help Click this to display an overview of this dialog box.

Windows 95 Modem Configuration dialog box
 Quick Steps
 Related Topics
 Tips

Configuring a modem port for your modem is usually sufficient. In some cases, however, default settings may 
have to be changed to fine tune the way in which your modem and LapLink work together.

Hint: If you are having a problem connecting over a modem, click Related Topics and then click a Troubleshooting 
topic.

Option Description

Installed Modems Lists modems currently installed on your computer.

To change settings for a modem, click the modem’s name and then 
change settings in this dialog box.



Add Click this to install a new modem using the Windows 95 Install New 
Modem wizard.

Properties Click this to verify the Windows 95 settings for the selected modem.

Auto Answer If Enabled is checked, LapLink will automatically answer incoming calls 
if your computer is running LapLink.

Type the number of rings allowed before LapLink answers an incoming 
call in the Answer Rings box.

Callback Timeout Type the time (in seconds) that LapLink should wait to establish a 
connection after dialing the callback number.

Callback Delay Type the time (in seconds) that LapLink will wait before calling back 
another computer. This time is used only when the remote computer is 
requesting a callback. 

Hint: Increase this value if the modem on the other computer takes a 
long time to reset itself.

Redial Attempts Type the maximum number of times that LapLink will redial a number if 
the first attempt to connect fails.

Redial Delay Type the time (in seconds) LapLink should wait after a connection has 
failed before redialing the modem.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Defaults Click this to restore the original settings.

Help Click this to display an overview of this dialog box.

Rename command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Renames the selected file or folder. Type the new folder or file name directly in the File Transfer window.



Select All command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Selects all files and folders in the open folder.



Clear Selection command (File Transfer only)
 Quick Steps 
 Related Topics 
 Tips

Clear all selections in the active file pane. LapLink deselects any selected files or folders.



Exit command
 Quick Steps 
 Related Topics
 Tips

Quits LapLink for Windows 95, closing all service windows. The next time you startup, LapLink attempts to 
automatically restore the connection that you previously saved and selected in the Connection File list on the 
Startup tab of the Connect Options dialog box.



Undo command (Chat only)
 Quick Steps
 Related Topics
 Tips

Reverses the last editing action in the Chat window. Undo reverses the Cut and Paste commands and your most 
recent typing.



Cut command (Chat only)
 Quick Steps
 Related Topics
 Tips

Removes the selected text from the lower pane of a Chat window and places it on the Windows clipboard.



Copy command (Chat only)
 Quick Steps
 Related Topics
 Tips

Places the text selected in either pane of a Chat window on the Windows clipboard.



Paste command (Chat only)
 Quick Steps 
 Related Topics
 Tips

Places the contents of the Windows clipboard at the insertion point in the lower pane of a Chat window.

To send the pasted text to the remote computer, press Enter.



Select All command (Chat only)
 Quick Steps 
 Related Topics
 Tips

Selects all text in the current Chat pane. You can then copy the text to the Windows clipboard using the Copy 
command. Use the Cut command to delete text from the lower pane or to remove it to the Windows clipboard.



Select Modem dialog box
 Quick Steps
 Related Topics
 Tips

Selects a modem when multiple modems are available.

Option Description

Modem Lists all available modem ports, if you have more than one enabled.

OK Click this to continue attempting to dial.

Cancel Click this to close this dialog box without saving any changes you made.

Port Setup Click this to change port settings, to enable and disable ports, or to change your 
modem type.

Help Click this to display an overview of this dialog box.

Hang Up Modem command
 Quick Steps
 Related Topics
 Tips

Ends the modem connection if there is an active modem connection. Otherwise, this command resets the modem.



Blank Host Screen command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Darkens the screen of the host computer when you are a Remote Control guest.

You must have permission from the host to blank its screen. The host grants locking privileges by clicking  
or Security on the Options menu.

To restore the image to the host screen, click Blank Host Screen again to remove the check mark.



Lock Host Mouse command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Disables the mouse of the host computer when you are a Remote Control guest.

You must have permission from the host to disable its mouse. The host grants locking privileges by clicking  
or Security on the Options menu.

To restore use of the host's mouse, click Lock Host Mouse again to remove the check mark.



Lock Host Keyboard command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Disables the keyboard of the host computer when you are a Remote Control guest.

You must have permission from the host to disable its keyboard.    The host grants locking privileges by clicking 

 or Security on the Options menu.

To restore use of the host's keyboard, click Lock Host Mouse again to remove the check mark.



Reboot Host command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Reboots the host computer when you are a Remote Control guest.

You must have permission from the host to reboot it on command. The host grants locking privileges by clicking 

 or Security on the Options menu.



Full Screen command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Displays the host computer's screen full-size on your local computer during Remote Control. Your entire screen is 
devoted to displaying the host computer.

If the host screen is a higher resolution and doesn't fit within the window, you can use the scroll bars on your local 
computer to move around the remote computer's screen.



Scale to Fit command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

Scales the host computer's screen to fit proportionally within a window on your local computer during Remote 
Control. The resolution of this view is not as sharp as on the remote computer's screen, but you will see the entire 
screen. In addition, if you change the size of the Remote Control window as it appears on your screen, the host 
image can be stretched out of proportion vertically or horizontally. 



Large Icons command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays files in the active File Transfer window using large icons.



Small Icons command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays files in the active File Transfer window using small icons.



List command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays files in the active File Transfer window alphabetically, or in the order specified using the Arrange Icons 
command.



Detail command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays files in the active File Transfer window alphabetically with complete information on the files and folder, or 
in the order specified using the Arrange Icons command.



Arrange Icons command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Commands Description

Sort by Name 
command (File 
Transfer only)

Sorts files alphabetically in the active file pane by name, with folders before files.

File names are arranged alphabetically (A to Z) and from the smallest number to the 
largest. Click the Name button to reverse this order.

Sort by Type 
command (File 
Transfer only)

Sorts files in the active file pane by type (file name extension), with folders before 
files. 

File extensions are arranged alphabetically (A to Z) and from the smallest number 
to the largest. Click the Type button to reverse this order.

Sort by Size 
command (File 
Transfer only)

Sorts files in the active file pane by size. Files are displayed from largest to 
smallest. Click the Size button to reverse this order.

Sort by Date 
command (File 
Transfer only)

Sorts files in the active file pane by date and time. Files are displayed from oldest to 
newest. Click the Modified button to reverse this order.

Sort by Attributes 
command (File 
Transfer only)

Sorts files in the active file pane by attribute. Files are displayed in this order:    r, a, 
s, h (r for Read Only, a for Archive, s for System, h for Hidden). Click the Attrib. 
button to reverse this order.

Hint: To display files with the hidden and system attributes, click Filter from the View 
menu and then click Show Hidden/System Files. Make sure that the filter is *.

Toolbar command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays or hides the File Transfer Toolbar, which is the bar of buttons at the top of the File Transfer window.



Status Line command (File Transfer only)
 Quick Steps
 Related Topics
 Tips

Displays or hides the status line, which is at the bottom of the active File Transfer window. When the status line is 
displayed, the command has a check mark next to it.

The status line displays one of the following:

If a folder is selected, the number of files in the folder and the amount of total and free disk space.
If one or more files is selected, the number and total size of the selected files.



LinkBar command
 Quick Steps
 Related Topics
 Tips

Displays or hides the LinkBar. The LinkBar contains buttons for quick access to commonly used commands.
When displayed, the LinkBar appears below the menu bar, and a check mark appears next to the command on the 
Options Menu. When the LinkBar is hidden, there is no check mark.



Status Line command
 Quick Steps
 Related Topics
 Tips

Displays or hides the status line. The status line displays a brief help message when you place the mouse pointer 
over a button or highlight a command on a menu.

When displayed, the status line appears at the bottom of the LapLink window, and a check mark appears next 
Status Line on the Options Menu. When the status line is hidden, there is no check mark.



Save Connections command
 Quick Steps
 Related Topics
 Tips

Saves a file of the services and connections in use. You can then instruct LapLink to restore the services and 
connections at any time or the next time you start the program.

Option Description

Save in Specifies the folder where LapLink connection files are saved, which is by 
default \tsi32\data in the Windows installation folder.

File name Type the name or a description of the connection. This name will be the file 
name for the saved connection.

Save as type Specifies that this is a LapLink Connection File, and that the file name 
extension will be .LLC.

Create a 
shortcut to this 
file on the 
desktop

If checked, LapLink will create a shortcut icon and place it on the Windows 95 
Desktop so that the connection can be easily reestablished.

To restore the connection, double-click the shortcut icon.

Save Click this to save the connection file, and close this dialog box.

Cancel Click this to close this dialog box without saving any changes you made.

Restore Connections command
 Quick Steps
 Related Topics
 Tips

Opens the selected connection and the services that were in use when this connection was saved.

Option Description

Look in Specifies the folder where LapLink connection files are saved, which is by 
default \tsi32\data in the Windows installation folder. 

File name Type the name or a description of the connection. This name will be the file 
name for the saved connection.

To select a file name from the list box, click it and its name appears here.

Files of type Specifies that you are looking for a LapLink Connection File, and that the file 
name extension will be .LLC.

Open Click this to open the connection file selected in File name, and close this 
dialog box.

Cancel Click this to close this dialog box without saving any changes you made.

Open Local File Window command
 Quick Steps
 Related Topics
 Tips

Opens two local File Transfer windows and display them on top of the LapLink window. You can then transfer files 
between local drives and perform other file-management activities.

If you have at least one local File Transfer window open, this command opens a new one.



Open File Transfer command
 Quick Steps
 Related Topics
 Tips

Once you have connected to another computer, opens a local and a remote File Transfer window and displays 
them on top of the LapLink window. You can then transfer files between the computers.

If you have already opened local and remote File Transfer windows, this command displays them on top of the 
LapLink window and makes the remote window active.



Open Remote Control command
 Quick Steps
 Related Topics
 Tips

Opens a Remote Control window for your current connection so that you can control the remote computer. If you 
are already connected and have opened a Remote Control window for that connection, this command activates 
the window and brings it to the top of the window.



Open Chat command
 Quick Steps
 Related Topics
 Tips

Opens a Chat window for the current connection so that you can exchange written messages with the remote 
user. A Chat window is opened on both computers.

If you already have a Chat window open, this command activates the window and brings it to the top of the 
window.



Cascade command
 Quick Steps
 Related Topics
 Tips

Arranges all open windows within the LapLink window so they overlap. The title bar of each window remains 
visible, making it easy for you to select any window:



Tile Side by Side command
 Quick Steps
 Related Topics
 Tips

Arranges all open windows so they can be viewed side by side with no overlap.



Tile Vertically command
 Quick Steps
 Related Topics
 Tips

Arranges all open windows so they can be viewed top to bottom with no overlap.



Arrange Icons command (Window menu)
 Quick Steps 
 Related Topics
 Tips

Arranges all minimized LapLink for Windows icons across the bottom of the LapLink window with no overlap.



Refresh command
 Quick Steps
 Related Topics
 Tips

Updates the active File Transfer or Remote Control window.



Close All command
 Quick Steps
 Related Topics
 Tips

Closes all service windows and icons in the LapLink window and break all connections without exiting LapLink.



Window List command
 Quick Steps
 Related Topics
 Tips

Lists currently opened service windows and windows that are now icons. If you click a name in the list, it becomes 
the active window.

As you open service windows, LapLink lists them at the bottom of the Window menu. You can use this list to 
select a service and make it active.



Shortcut keys
 LapLink commands
 Xchange Agent shortcut keys

Many commands have shortcut keys. Press these keys or combinations of keys to quickly choose commands.

Click a command to view more information.

Command Shortcut keys Command Shortcut keys

Cascade Shift+F5 Paste (Chat only) Ctrl+V

Clone Folder (File 
Transfer only)

F7 Refresh (File 
Transfer or Remote 
Control)

F5

Copy (Chat only) Ctrl+C Rename (File 
Transfer only)

Ctrl+R

Copy (File Transfer 
only)

Ctrl+C or F2 Scale to Fit (Remote 
Control only)

Ctrl+Shift+S

Cut (Chat only) Ctrl+X Select By (File 
Transfer only)

Ctrl+B

Delete (File Transfer 
only)

Ctrl+D or Del Size of Selections (File 
Transfer only)

Ctrl+S

Exit Alt+F4 SmartXchange (File 
Transfer only)

F9

Full Screen (Remote 
Control only)

Ctrl+Shift+F Tile Side by Side Shift+F3

Make Folder (File 
Transfer only)

Ctrl+K Tile Vertically Shift+F4

Move (File Transfer 
only)

Ctrl+M or F4 Undo (Chat only) Ctrl+Z

Help Topics command
 Quick Steps
 Related Topics

Displays the Help Topics dialog box that you can find topics to help you accomplish tasks. View information about 
using LapLink.

Click the Contents tab to view an expandable table of contents for online help topics.
Double-click the Quick Steps for LapLink book for step-by-step instructions on completing tasks using 

LapLink.
Double-click the Quick Steps for Xchange Agent book for step-by-step instructions on completing tasks 

using Xchange Agent.
Double-click the Online Reference for LapLink book for information on LapLink menu commands, buttons, 

and dialog boxes.
Double-click the Online Reference for Xchange Agent book for information on Xchange Agent menu 

commands, buttons, and dialog boxes.
Double-click the Troubleshooting book for step-by-step instructions for solving problems.
Click the Index tab to view a list of keywords for searching the online help.
Click the Find tab to search the complete text of the online help.



Quick Steps command
 Quick Steps
 Related Topics
 Tips

Turns Quick Steps on so that step-by-step instructions for each dialog box appear automatically. Turn Quick Steps 
off by clicking Quick Steps in the Help menu so that it is not checked.



About LapLink for Windows command
 Quick Steps
 Related Topics

Displays information about LapLink, including version and copyrights.



Control menu commands

Commands Description

Restore Restores the window to its previous size after it has been maximized or minimized.

Move Enables you to use the keyboard to move the window to another position.

Size Enables you to use the keyboard to change the size of the window.

Minimize Reduces the window to an icon.

Maximize Enlarges the window to its maximum size.

Close Closes LapLink for Windows 95, or closes the dialog box.

Next Opens the next File Transfer window, which is listed after the current window in the 
Window menu.

Chat Options command
 Quick Steps
 Related Topics
 Tips

Sets options for notifying you when you receive a Chat message while working in another application.

Option Description

Restore Chat 
window 
automatically

If checked, the Chat window is displayed automatically on top of other service 
windows whenever a remote user sends a message. If LapLink is minimized, it will 
be restored.

If cleared and you are connected to another computer, the Chat window must be 
visible for you to know when you have received a message.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Link Clipboards command (Remote Control only)
 Quick Steps
 Related Topics
 Tips

When checked, the clipboards on the connected computers is shared. You can paste information that was last 
saved to the clipboard from any of the connected computers.

When there is no check mark, clipboard information can only be used on the computer from which it was copied or 
cut.





Tips for Copy command

Ö Press Ctrl+C or F2 to quickly copy selected files and folders.

Ö Copying duplicates the files in the source and target folder. If you want to remove the files from the source folder, move them 
instead.

Ö Pressing Ctrl while dragging files and folders copies them.

Ö Pressing Shift while dragging files and folders moves them.

Ö Before copying files, click Size of Selections on the File menu to ensure that there is enough room on the target drive.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Move command

Ö Press Ctrl+M or F4 to quickly move selected files and folders.

Ö Moving removes files from the source folder. If you want the files to be kept in the source folder, copy them instead.

Ö Pressing Ctrl while dragging files and folders copies them.

Ö Pressing Shift while dragging files and folders moves them.

Ö Before moving files, click Size of Selections on the File menu to ensure that there is enough room on the target drive.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Protected Files dialog box

Ö LapLink recognizes two kinds of protected files: read-only files (specified through File Transfer Options) and operating system 
files.

Ö When this dialog box opens, protected files listed in this dialog box have not yet been copied or moved. The other files that 
were selected have already been transferred.

Ö If you prefer to OK when each file is overwritten, click File Transfer Options on the Options menu. Click the Confirmation tab, 
and then click Verify all file overwrites so that it is checked.

Ö If you prefer to have read-only files automatically overwritten or deleted when moved, click File Transfer Options on the 
Options menu. Click the Confirmation tab, and then click Verify read-only file overwrites/deletions so that it is not checked.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Delete command

Ö Press Ctrl+D or Del to quickly remove the selected files and folders.

Ö In LapLink, Delete removes the file completely. Delete does not place the file or folder in the Windows 95 Recycle Bin.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Rename command

Ö Press Ctrl+R to quickly rename the selected file or folder.

Ö To rename a file or folder directly in the File Transfer window, click the file or folder name until a cursor appears.

Ö If you click Rename on the File menu, the selected file or folder name can be edited.

Ö Be careful when renaming a file’s extension. Changing a file’s extension can change its file type, which Windows 95 uses to 
choose the program that opens the file.



Tips for Create Short File Names dialog box

Ö These locations may accepts only short file names: network drives; computers running LapLink 6; computers running earlier 
versions of Windows.

Ö You can use any valid DOS file name, which is usually limited to eight characters plus a three-character extension.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Select All command

Ö Press Ctrl+A to quickly select all the files and folders in the file (right) pane of the active File Transfer window.

Ö To expand or collapse drives and folders, click     or 
 next to the drive or folder.

Ö To open a folder, double-click it.
Ö To select everything in a drive, click the drive in the tree (left) pane.



Tips for Select By command

Ö Press Ctrl+B to quickly select files with similar names and dates.

Ö To expand or collapse drives and folders, click     or 
 next to the drive or folder.

Ö To open a folder, double-click it.
Ö Typing wildcards (for example, win?.*,    *.exe, *.ini) in the Filter box allows you to select files or folders with similar 
names.
Ö You can specify several criteria by inserting a space or a comma between them.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Clear Selection command

Ö To clear selections individually, press the Ctrl key and click the individual file or folder.



Tips for Size of Selections command

Ö Press Ctrl+S to quickly view the size of the selected files.

Ö Before transferring files, compare the Size of Selected Files figure with the number of bytes free on the target drive or folder 
to ensure that the selected files will fit on the target.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Make Folder command

Ö Press Ctrl+K to quickly create a folder.

Ö Check the window’s title bar to make sure that you have the correct drive or folder open. The full path will appear.

Ö You do not have to use Make Folder when you copy or move folders. LapLink creates the folder automatically when 
transferring files.

Ö To make a folder at the root level of a drive, be sure to select the drive icon in the tree (left) pane before clicking Make Folder.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Exit command

Ö Press Alt+F4 to quickly exit LapLink.

Ö To close a service but keep LapLink running, close the window.

Ö To restore your current connections and services the next time you start LapLink, click Save Connections on the Connect 
menu and then save a connection file. 

Also click Connect Options on the Options menu, and then click Restore Saved Connections at Startup on the Startup tab so 
that it is checked. Select the saved connection in the connection file list, and then click either Automatically Connect at 
Startup or Ask Before Connecting.



Tips for Undo command

Ö Press Ctrl+Z to quickly undo the last editing action.

Ö Chat only works with ASCII text. You can copy and paste between WordPad, or any other text editor, and the Chat window.



Tips for Cut command

Ö Press Ctrl+X to quickly cut the selected text.

Ö You can cut text only from the lower pane of a Chat window.

Ö To reverse text editing in a Chat window, click Undo on the Edit menu.

Ö To select all the text, click Select All on the Edit menu.

Ö Chat only works with ASCII text. You can copy and paste between WordPad, or any other text editor, and the Chat window.



Tips for Copy command

Ö Press Ctrl+C to quickly copy the selected text.

Ö To select all the text, click Select All on the Edit menu.

Ö To reverse text editing in a Chat window, click Undo on the Edit menu.

Ö You can paste all or part of your conversation into a word processing program or text editor, where you can save it for future 
use.

Ö Chat only works with ASCII text. You can copy and paste between WordPad, or any other text editor, and the Chat window.



Tips for Paste command

Ö Press Ctrl+V to quickly paste text from the Windows clipboard into the Chat window.

Ö You can paste text only into the lower pane of a Chat window.

Ö You can paste text into Chat from word processing or text files.

Ö Chat only works with ASCII text. You can easily copy and paste between WordPad, or any other text editor, and the Chat 
window.

Ö To select all the text, click Select All on the Edit menu.

Ö To reverse text editing in a Chat window, click Undo on the Edit menu.



Tips for Select All command

Ö Press Ctrl+C to quickly copy the selected text.

Ö A Chat conversation can contain approximately 30K (or about 30,000 characters) of text. When that limit is reached, the most 
recent text replaces the oldest text.

Ö After you select all the text, you can copy the text and then paste it into a word processing or text file.

Ö Chat only works with ASCII text. You can copy and paste between WordPad, or any other text editor, and the Chat window.



Tips for Connect over Cable command

Ö If you have both a serial and parallel port available, keep in mind that parallel cables transfer data two to four times faster 
than serial cables.

Ö You can use LapLink parallel and serial cables, ECP cables, and some serial cables from other manufacturers.

Ö For a serial connection, choose the blue cable (it’s labeled SERIAL) and attach one of the connectors at each end a 
computer.

Ö For a parallel connection, choose the yellow cable (it’s labeled PARALLEL) and attach each connector to a computer.

Ö Be sure to connect each end of either the serial or parallel cable to the appropriate port on each computer.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Connect over Wireless command

Ö Initially, LapLink assumes you have installed IrDA, the Windows 95 Infrared communications driver version 1.0. If IrDA is not 
installed or you are using AirShare Radio modules, you must edit LLW.INI. Refer to the LapLink Installation and User's Guide 
for instructions.

Ö Initially, LapLink imposes no security protection on wireless connections. If you want security for wireless connections, click 
Security on the Options menu, and then click the Local Security tab. Click Enforce security for connections so that it is 
checked.

Ö Be sure to attach the same type of wireless device to the appropriate port on each computer. Both wireless devices should be 
turned on and receiving enough power to make a stable connection.

Ö Once the wireless devices are within range of each other, Autoconnect makes the link for you. Autoconnect is useful when 
two computers transfer files regularly.

Ö To connect over a cellular modem, use Connect over Modem.

Ö To connect over a wireless LAN adapter, use Connect over Network.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Connect over Modem command

Ö Before you dial a modem, make sure that the modem is turned on and is securely connected to your computer and phone 
line.

Ö LapLink security is initially set to Nobody (Private System). Other computers cannot connect to your computer over a modem 
or network until you change the security settings.

Ö Initial security settings may need to be changed on the remote computer before it will allow an incoming connection.

Ö Use an Address Book entry when connecting over modem, even if you need to change the phone number or Dialing 
Properties.

Ö Use the Windows 95 Dialing Properties to simplify dialing your modem. Click this for information    .
Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Select Modem dialog box

Ö If you experience problems with Windows programs trying to use the same modem port, select the port you want LapLink to 
use exclusively.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Connect over Network command

Ö No one can connect to your computer over the network until you change security settings. Click        to allow other 
computers to connect to your computer.

Ö Before you can connect using your network, networking must be installed. You don't have to be logged into the network to 
connect over network.
Ö Use the Address Book to simplify connecting over a TCP/IP network. In each entry you can record the log-in name and 
password required by the remote computer You can also request the kinds of services you want to use when you connect.

Ö You can connect to more than one computer at a time over the network.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Disconnect command

Ö To restore your current connections and services, click Save Connections on the Connect menu. You can then instruct 
LapLink to restore the services and connections at any time or the next time you start the program.

Ö To restore the services and connections the next time you start LapLink, click Connect Options on the Options menu, and 
then click Restore Saved Connections at Startup on the Startup tab so that it is checked. Select the saved connection in the 
connection file list, and then click either Automatically Connect at Startup or Ask Before Connecting.

Ö You can also break connections by closing the service windows for that connection.

Ö To close a modem connection, you can also click Hang Up Modem on the Connect menu.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Dialing Status dialog box

Ö If you get an message in this dialog box that you cannot resolve, use the Troubleshooting section of online help. Click this    
    to open the Modem Connections Troubleshooter.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Hang Up Modem command

Ö Click Hang Up Modem on the Connect menu to quickly break a modem connection.

Ö If you see a "No Carrier" message, your modem is no longer responding. Try resetting the modem by clicking Hang Up 
Modem, and then dial again.



Tips for Blank Host Screen command

Ö You can blank the host's screen only when the host computer grants you permission.

Ö From the Session menu, you can determine which locking commands are available and which are not. Any command that is 
grayed is not available.



Tips for Lock Host Mouse command

Ö You can lock the host's mouse only when the host computer grants you permission.

Ö From the Session menu, you can determine which locking commands are available and which are not. Any command that is 
grayed is not available.



Tips for Lock Host Keyboard command

Ö You can lock the host's keyboard only when the host computer grants you permission.

Ö From the Session menu, you can determine which locking commands are available and which are not. Any command that is 
grayed is not available.



Tips for Reboot Host command

Ö You can reboot the host's computer only when the host computer grants you permission.

Ö From the Session menu, you can determine whether rebooting is allowed. If the command is dimmed then rebooting is not 
allowed.



Tips for Full Screen command

Ö Use this command when you’re mainly using LapLink for Remote Control.

Ö To switch between window and full-screen view, press Ctrl+Shift+F.

Ö To switch between scaled-to-fit and normal view, press Ctrl+Shift+S.

Ö You can change the key combination for this command by clicking Remote Control Options on the Options menu, and then 
clicking the Guest tab. Type your key combination in the Full-screen Toggle box.

Ö To make Remote Control switch between full screen and icon, bypassing the window view, click Remote Control Options on 
the Options menu and then click the Guest tab. Click Always Use Full Screen so that it is checked.



Tips for Scale to Fit command

Ö Use this command when you’re mainly using LapLink to see all the host computer’s screen, or when you need to see more 
than one computer on your screen.

Ö To switch between window and full screen view, press Ctrl+Shift+F.

Ö To switch between scaled-to-fit and normal view, press Ctrl+Shift+S.

Ö When the host image is scaled to fit, you do not have to use the scroll bars to see different parts of the screen.

Ö You can change the key combination for this command by clicking Remote Control Options on the Options menu, and then 
clicking the Guest tab. Type your key combination in the Scaling Toggle box.



Tips for Filter command

Ö The filter currently being used appears in the title bar of the File Transfer window.

Ö Filters only affect the display of files and folders in the file (right) pane. The tree (left) pane is not affected.

Ö Filters only affect the current File Transfer window. All other open File Transfer windows are not affected. If you open a new 
File Transfer window, files are displayed using the current filter setting.

Ö You can enter several criteria at once by inserting a space or a comma between them. For example: *.DOC, *.TXT

Ö When you copy, move, or delete a folder, every file in the folder is copied, moved, or deleted, regardless of the filter setting. 

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Large Icons command

Ö You can also click  in the File Transfer window.
Ö To reorder files and folders, click one of the Arrange Icons commands.



Tips for Small Icons command

Ö You can also click  in the File Transfer window.
Ö To reorder files and folders, click one of the Arrange Icons commands.



Tips for List command

Ö You can also click     in the File Transfer window.
Ö To reorder files and folders, click one of the Arrange Icons commands.



Tips for Detail command

Ö You can also click  in the File Transfer window.
Ö To reorder files and folders, click one of the Arrange Icons commands.



Tips for Arrange Icons command

Ö To sort a detailed file list, click the buttons at the top of the file list: Name, Size, Type, Modified, or Attributes.

Ö The initial sorting order is by name with folders listed first, followed by files.

Ö You can only sort by one detail at a time.

Ö To switch between ascending and descending order in a detailed file list, click the Name, Size, Type, Modified, or Attributes 
button again.



Tips for Toolbar command

Ö Hide the File Transfer Toolbar when screen space is limited, such as on a laptop.

Ö If you hide the Toolbar, click commands on the File and View menus to transfer and display files and folders.



Tips for Status Line command

Ö Hide the File Transfer status line when screen space is limited, such as on a laptop.

Ö To view all of the information available in the status line, you may have to resize the File Transfer window.



Tips for Clone Folder command

Ö Press F7 to quickly display the Clone Folder dialog box.

Ö Use the Clone Folder command with caution. This command deletes files from the target folder.

Ö Use Clone Folder to maintain a backup folder. Extra files in the folder are deleted before copying the new files so that old 
unused files don’t accumulate.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for SmartXchange command

Ö Press F9 to quickly display the SmartXchange dialog box.

Ö Use SmartXchange to automate archiving the files and folders you use most to the network.

Ö SmartXchange does not merge the contents of two files so that you have information from both files. Instead, the newer file 
overwrites the older file so that the older file is identical to the newer file.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for SpeedSync Statistics command

Ö To delete all statistics from the history, click Reset History. Only the statistics for the most recent transfer are retained.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for File Transfer Options command

Ö If you click Files and Folders on the Confirmation tab so that they are not checked, you are still asked to confirm the deletion 
of read-only files unless you also click Verify read-only file overwrites and deletions so that it is not checked.

Ö If you are on the road and simply want to back up your working files to your home computer, you can cut transfer time by 
selecting both Transfer only if files are newer and Transfer only if files are already on target on the Filter tab.

Ö When you confirm a copy or a move, you can change the settings for that individual operation.

Ö Initially, Compression is turned on. If your files are already compressed, turning Compression off may speed transfer times. 
To turn Compression off, click the Performance tab, and then click Use Compression so that it is cleared.

Ö Initially, SpeedSync is turned on. SpeedSync decreases transfer times when updating files that already exist on the target. If 
your files have changed extensively, click Use SpeedSync on all file transfers on the Performance tab so that it is cleared.

Ö These File Transfer settings also apply to Xchange agents: Enable File Transfer Recovery on the Copy/Move tab, Use 
Compression on the Performance tab, and Use SpeedSync on the Performance tab.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Remote Control Options command

Ö During a Remote Control session, guests can change the kind of locking using commands on the Session menu.

Ö When the guest and host want to reverse the direction of remote control, the current Remote Control connection must be 
broken. Then the previous host must initiate and open the connection to become a guest.

Ö Windows system keys always take effect on the host when you are using Remote Control in the full screen view.

Ö As a host, you can only host one Remote Control session at a time. As a guest, you can control several remote host 
computers at the same time.

Ö You can lock the host with a command during a Remote Control session, or you can pre-set the locking request with an 
Address Book entry. Locking takes effect on connection, and can be removed during a Remote Control session.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Remote Control Performance Options dialog box

Ö When the guest and host want to reverse the direction of remote control, the current Remote Control connection must be 
broken. Then the previous host must initiate and open the connection to become a guest.

Ö As a host, you can only host one Remote Control session at a time. As a guest, you can control several remote host 
computers at the same time.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Address Book command

Ö Use Address Book entries to streamline your most frequent connections. For example, if you want to be the only person to 
connect, set up an Address Book entry to store your security information.

Ö When you want to limit those connections approved by your computer, use the Log-in List to limit connections. Then those 
users can connect to you using their Address Books.

Ö To open a connection, use one of the Connect over menu commands or buttons on the LinkBar.

Ö If you set password protection for your computer, you are asked to type your password before the Address Book dialog box 
opens.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Add, Edit, and Copy Address Book Entry dialog boxes

Ö You can create more than one Address Book entry for a computer name if you want to have different types of connections 
available. If you have two with the same name in your Address Book, they are listed with connection type after the computer’s 
name.

Ö Your requests for services and privileges will be honored if the remote computer’s security allows.

Ö Before you make a connection requesting locking, the remote computer’s user must grant you locking privileges.

Ö The computer name in your Address Book must be the same as the name in the remote computer’s Computer Name dialog 
box.

Ö The Log-in Name and Password is set up by the remote user in their Log-in List.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Security command

Ö Initially, security is set to Nobody (Private System). Other computers cannot connect to your computer over a modem or 
network until you change the security settings.

Ö Passwords are not case-sensitive: capitals and lowercase letters are equivalent.

Ö When connecting over a modem, use callback protection to further secure your data. Callback protection forces modem 
users to be called back at a specific number so that strangers cannot connect even if they have your modem number.

Ö Setting a security password limits access not only to the Security command itself but to any other commands that contain 
security information: Address Book, Connect over Modem, Connect over Network, Remote Control Host Options, and 
portions of Logging.

Ö If you select Log-in List Only on the General tab, you must add computers to your log-in list. Click the Log-in List tab, and 
then click Add.

Ö Encryption is determined entirely by the setting on the guest computer, which must be set before connecting to the host 
computer.

Ö LapLink uses a standard encryption/decryption algorithm.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Add, Edit, and Copy Log-in List Entry dialog boxes

Ö To change a user's privileges, click the remote user’s name on the Log-in list tab, and then click Edit, Copy, or Delete.

Ö Passwords are not case-sensitive: capitals and lowercase letters are equivalent.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Change Password dialog box

Ö Passwords are not case-sensitive: capitals and lowercase letters are equivalent.

Ö If you have previously specified a local security password, you are asked to type it before opening the Security dialog box.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Computer Name command

Ö When you change your computer name, notify users who frequently connect to your computer so that they can update their 
Address Book entries for your computer.

Ö Use a descriptive name for your computer. For example, you may want to include the type of computer: Koshi's 486.

Ö All service windows, even local File Transfer windows, must be closed before you can change your computer’s name.

Ö Computer names can be no longer than 20 characters.

Ö On a network, each computer name used in LapLink should be unique. To avoid conflicts, use your network log-in name.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Port Setup command

Ö If you’re enabling a modem, use Win95 Modems in the Ports list so that other programs can share your modem.

Click     for information about choosing between Win95 Modems and COM ports.
Ö If you give LapLink exclusive use of a modem and want to use another communications program, first exit LapLink to use 
the other program. Or, you can disable the modem port in LapLink instead and enable Win95 Modems in the Ports list.

Ö When LapLink is running, it periodically "queries" any enabled port. If another program is also trying to use that port, try 
temporarily disabling it for use in LapLink.

Ö You can enable more than one port.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Network (IPX) Port Setup dialog box

Ö Before you can connect to a computer by network, Windows 95 must be properly set up for networks. Specifically, the 
IPX/SPX-compatible protocol must be installed and bound to an adapter.

Ö You don't have to be actually logged onto the network to connect in LapLink.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Parallel Port Setup dialog box

Ö Use LapLink or DirectParallel Universal cables. LapLink does not work over any printer cables.

Ö As soon as the parallel ports on both computers are enabled and the cable is attached, LapLink automatically makes the 
connection and opens File Transfer windows for both computers.

Ö Parallel cables transfer data two to four times faster than serial cables.

Ö The LapLink standard driver transfers data in 4-bit mode, the LapLink enhanced driver uses 8-bit mode, and the Windows 
driver varies depending on the port’s settings. LapLink will attempt to match this driver to your hardware and to the other 
computer’s settings. If you are having problems connecting, try clicking Use the LapLink standard driver, and then attempt to 
connect.

Ö When you are using a parallel port modem, the modem is physically connected to a parallel port but uses software to make it 
look like the modem is connected to a serial port. Check your modem documentation to see which COM port it is configured 
for, and then enable that serial (COM) port instead of the parallel port.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Cable (Serial) Port Setup dialog box

Ö Initially, LapLink imposes no security protection on serial connections. If you want security, click Security on the Options 
menu, and then click the Local Security tab. Click Enforce Security for Connections so that it is checked.

Ö If you are having problems making a connection over serial cable, try setting the Transfer Mode to Standard.

Ö Use only a LapLink cable to connect your computers. LapLink does not work over most other serial cables.

Ö After using a cable, disable the COM port and then enable Win95 Modems.

Ö If you give LapLink exclusive use of a serial port and want to use another communications program, first exit LapLink. Or, 
disable the port in LapLink and then enable Win95 Modems.

Ö When configuring the port, make sure that you follow the manufacturer's specifications.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Wireless Port Setup dialog box

Ö Initially, LapLink imposes no security protection on wireless connections. If you want security, click Security on the Options 
menu, and then click the Local Security tab. Click Enforce Security for Connections so that it is checked.

Ö If you give LapLink exclusive use of a COM port and want to use another communications application, exit LapLink. Or, 
disable the port in LapLink and then enable Win95 Modems.

Ö When configuring the port, make sure that you follow the manufacturer's specifications.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Modem Setup dialog box

Ö If you specified your modem model, you should be ready to communicate over modem with LapLink. Be sure the modem is 
turned on and physically connected to your computer and phone line.

Ö If you have more than one port enabled for modems in LapLink, click Port Setup to enable Win95 Modems or to disable the 
extra modem port.

Ö Click     for information about choosing between Windows 95 Modems and COM ports.

Ö If you have trouble connecting over a modem, set both modems to the same speed. Use the highest speed supported by 
both modems.

Ö If you give LapLink exclusive use of a modem and want to use another communications application, exit LapLink. Or, disable 
the port in LapLink and then enable Win95 Modems.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Modem Customization dialog box

Ö Consult the modem’s documentation for information on each of these settings.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Windows 95 Modem Configuration dialog box

Ö Use the Windows 95 modem setup so that other programs can share the modem.

Click     for information about choosing between Windows 95 Modems and COM ports.
Ö Before you enable a modem port, make sure your modem is turned on and is securely connected to your computer and 
phone line.
Ö If you give LapLink exclusive use of a modem and want to use another communications application, exit LapLink. Or, 
disable the port in LapLink and then enable Win95 Modems.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Logging command

Ö A new log file is created each day. To view older log files, open them in any program (such as WordPad or NotePad) that 
supports ASCII text format.

Ö To save space on your hard drive, lower the number in the Maximum Number of Log Files box to reduce the number of log 
files that LapLink maintains.

Ö When you reach the maximum number of log files saved, LapLink deletes the oldest log file before adding a new one.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for LinkBar command

Ö The buttons on the LinkBar give quick access to commands located in various menus. If you hide the LinkBar, you can still 
access the commands through the menus.

Ö If you need more space in LapLink to display services, click LinkBar on the Options menu so that it is not checked.



Tips for Status Line command

Ö If you need more space in LapLink to display services, click Status Line on the Options menu so that it is not checked.

Ö To change how a File Transfer window looks, use the commands on the View menu.



Tips for Connect Options command

Ö To fully automate the process of restoring saved connections at startup, click Restore Saved Connections at Startup and 
Automatically Connect at Startup.

Ö When you save a connection, the same connection type is used. If you attempt to restore a modem connection, for example, 
LapLink attempts to restore the connection by dialing your modem. If either of the modems is not ready, the connection 
cannot be made.

Ö Create Address Book entries for the saved connections. Include the log-in name and password required by the remote 
computers.

Ö Autoconnect is initially on and will automatically connect your computer over cable and wireless as soon as it "sees" the other 
computer.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Save Connections command

Ö To restore the services and connections, click Restore Connections on the Connect menu.

Ö To instruct LapLink to restore a saved connection at startup, click Connect Options on the Options menu, and then click 
Restore Saved Connections at Startup on the Startup tab so that it is checked. Select the saved connection in the connection 
file list, and then click either Automatically Connect at Startup or Ask Before Connecting.

Ö Connection files are saved in the \TSI32\data folder which is located in your Windows installation folder.

Ö Connection files use the file name extension .LLC.



Tips for Restore Connections command

Ö You can also use shortcuts to restore a saved connection. To create a shortcut that will appear on your Windows 95 Desktop, 
click Create a shortcut to this file on the desktop so that it is checked in the Save Connections dialog box. To restore the 
connection, double-click the shortcut icon.

Ö To instruct LapLink to restore a saved connection at startup, click Connect Options on the Options menu, and then click 
Restore Saved Connections at Startup on the Startup tab so that it is checked. Select the saved connection in the connection 
file list, and then click either Automatically Connect at Startup or Ask Before Connecting.

Ö Connection files are saved in the \TSI32\data folder which is located in your Windows 95 installation folder.

Ö Connection files use the file name extension .LLC.



Tips for Open Local File Window command

Ö When no connection exists, click Open File Transfer Window to open or display two File Transfer windows for the local 
computer.

Ö Initially, a File Transfer window displays the computer’s first hard drive (usually drive C).



Tips for Open File Transfer command

Ö To activate a window for an existing connection, click the window name at the bottom of the Window menu.

Ö When a connection exists, click     to open or redisplay both a remote and local window.

Ö When no connection exists, click     to open or re-display two local File Transfer windows. Clicking 

    is the same as clicking Open Local File Window on the Window menu.
Ö Initially, a File Transfer window displays the computer’s first hard drive (usually drive C).



Tips for Open Remote Control command

Ö To activate a window for an existing connection, click the window name at the bottom of the Window menu.

Ö Clicking Open Remote Control is the same as clicking        on the LinkBar.
Ö Once you have opened a Remote Control window, you can view the host computer, prevent interruptions on the host, and 
operate the host computer.
Ö To be a host (that is, to be controlled by another computer), just start LapLink for Windows. When another computer 
connects to your computer and opens a Remote Control service window, your computer automatically becomes a host. (You may 
need to change your initial security settings to allow the other computer to control your computer.)

Ö No one else can control your computer while you are remote controlling another computer. Also, a computer cannot be 
remote controlled by anyone else while you are controlling it.

Ö To fully automate the connection process, create an Address Book entry for the log-in name and password required by the 
remote computer, as well as the locking options you want to request when connecting to the host.

Ö The mouse operates the remote program only when the cursor resides in the Remote Control window.



Tips for Open Chat command

Ö Clicking Open Chat is the same as clicking        on the LinkBar.
Ö If you have connected to more than one computer, click a window for a particular connection before opening Chat.
Ö To activate a window for an existing connection, click the window name at the bottom of the Window menu.
Ö Opening a Chat window on one computer automatically opens a Chat window on the other, allowing for two-way 
communications.
Ö To bring the Chat window into the foreground when a connected remote computer sends a message, click Chat Options 
on the Options menu.

Ö A Chat conversation can contain about 30K (or 30,000 characters) of text. When that limit is reached, the most recent text 
replaces the oldest text. Chat is not intended for text file transfers; use File Transfer instead.



Tips for Cascade command

Ö To place a particular window on top, click it before choosing Cascade.



Tips for Tile commands

Ö If you do not want a window to be tiled, reduce it to an icon before choosing one of the Tile commands.



Tips for Arrange Icons command

Ö You can also drag icons with a mouse to rearrange them.



Tips for Refresh command

Ö Press F5 to quickly refresh the file display in a File Transfer window.

Ö Refresh the window if you have copied, moved, or deleted files outside LapLink while you had the File Transfer window open.



Tips for Close All command

Ö To close a single service window, click the close box in the upper right corner of the window.

Ö To close windows for all connections, click     or click Disconnect in the Connect menu. Then click Disconnect All.



Tips for Window List

Ö The names appearing in the window list include both open windows and windows that have been reduced to icons.



Tips for Log-in Name and Password dialog box

Ö This log-in name and password are assigned to you in the remote computer’s Log-in List. If you don’t know what to type, 
contact the owner of the remote computer.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Local Security Password dialog box

Ö To set this log-in name and password, click Security on the Options menu. Click the Local Security tab, and then click Set 
Password.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Callback Request dialog box

Ö Because remote settings in Windows 95 Dialing Properties are not used for callbacks, type the prefixes or suffixes that must 
be dialed.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Quick Steps command

Ö Place the Quick Steps help window so that it appears next to your LapLink dialog boxes for easier reading.



Tips for Chat Options command

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Link Clipboards command    (Remote Control only)

Ö You must connect to the other computer to turn Link Clipboards on or off.

Ö Clipboard information can be pasted into any document or application, just as you normally would.



Tips for Connecting over the Internet

Ö Before you can connect over the Internet, the Microsoft TCP/IP protocol stack must be installed. Do not install any other 
TCP/IP stack.

Ö If you are using a modem to dial into an Internet provider, TCP/IP must be bound to the Dial-Up Networking adapter. To check 
bindings, open the Windows 95 Network properties by double-clicking Network in the Control Panel. Click Dial-Up Adapter, 
click Properties, and then click the Bindings tab.

Ö In LapLink, the TCP/IP port must be enabled. Click Port Setup in the Options menu.

Ö To use your network for Internet connections, the network must be connected to the Internet, your computer must be set up 
with Microsoft TCP/IP software, and the network must allow LapLink connections. Consult your system administrator if in 
doubt.

Ö For repeat connections to a computer with a permanent Internet address, create an entry in Address Book. Identify the 
connection type as TCP/IP.

Ö To connect using WINS names, both computers must be configured for the same WINS server and the same Scope ID. 
Then, when connecting, type the WINS name in the IP Name or Address box in the Connect over Network dialog box.





Glossary of terms

The following are terms used in the LapLink for Windows online help and user’s guide. Click a word to see its 
definition.

A

Add Folder Pair button (Xchange Agent)

Address Book button

Autoconnect

B

C

Cable button

Callback

Chat button

Chat window

Clone

Close Preview button (Xchange Agent)

Compression

Conflict

Connection type

Connect over Cable button

Connect over Dial-Up Networking button

Connect over Modem button

Connect over Network button

Connect over Wireless button

Copy button

Cropped view

D



Delete button

Dialing Properties

Dialing location

Dial-Up Networking button

Dial-up server

Disconnect button

E

ECP

Edit mode (Xchange Agent)

Enable

Encryption

F

File Transfer button

File Transfer file pane

File Transfer tree pane

File Transfer window

Filter

Filter (Xchange Agent)

Folder

Full screen

G

Guest

H

Hidden file

Host

I

IrDA

IPX

J, K

L

LapLink menus

Left to Right Only button (Xchange Agent)

LinkBar

Local File Transfer window

Local security

Local transfer

Locking privileges

Log-in List

M

Modem button

Move button



N

Network button

New Xchange Agent button (Xchange Agent)

Next Conflict button (Xchange Agent)

O

Open Chat Window button

Open File Transfer Window button

Open Remote Control Window button

Open Xchange Agent button

P

Pane

Parallel

Password

Prefix

Preview mode (Xchange Agent)

Preview Xchange Agent button

Private system

Protected file

Public system

Q

R

Remote Control button

Remote Control window

Resolve Conflict button (Xchange Agent)

Right click

Right to Left Only button (Xchange Agent)

Run Xchange Agent button

S

Save Xchange Agent button

Scaled-to-fit view

Security button

Serial

Services

Shortcut keys

Skip Pair(s) button (Xchange Agent)

Sort by Attribute button

Sort by Date/Time button

Sort by Extension button

Sort by Name button

Sort by Size button

Source

SpeedSync



Status line

Status line (Xchange Agent)

Suffix

Sync button

Synchronize Both Directions button (Xchange Agent)

System file

T

Target

TCP/IP

TCP/IP address

Toolbar (Xchange Agent)

Tree pane

U

Undo Skip Pair(s) button (Xchange Agent)

Up One Level button

V

W

Windows system keys

Wireless button

X

Xchange Agent menus

Y, Z



    Address Book button

Displays your Address Book, where you can store information that will speed up the process of connecting to other computers.



Autoconnect

Automatically connects your computer to a remote computer that is connected to your computer by cable or by wireless device.

Initially, this option is turned on; this option can be turned off so that you manually connect over a cable or wireless device.



    Connect over Cable button

Opens a cable connection with another computer running LapLink. You can use either a serial or parallel LapLink cable.



Callback

A callback occurs when one computer attempts to connect to another. Instead of completing the connection, LapLink reverses the 
call by hanging up and then dialing the caller’s modem. When the caller’s modem answers, the connection is completed, and 
service windows are opened.



    Open Chat Window button

Opens or displays a Chat window for the remote computer after a connection has been made.



Chat window

Allows you talk by keyboard to a remote computer that you are connected to by cable, wireless, modem, or network.

When you open a Chat window, two windows open up: one for your computer and one for the remote computer. Text can be 
copied and pasted in these windows to and from the Windows clipboard. Text in the Chat window is not saved in any file, except 
by selecting and copying through the Windows clipboard into another Windows application.



Clone

Creates an exact copy of the folder and its files and subfolders.



Compression

Compacts files during file transfer, and then decompresses files onto target folder so that the transferred file is the same size as 
the source file.

Use Compression to speed up file transfers over slower speed modems and serial cable.



Connection type

One of several methods you can use to connect to another computer, such as cable, modem, wireless device, network, or Dial-Up 
Networking.



    Copy button

Creates a copy of the selected files and folders on the target drive or folder.



Cropped view

Displays a portion of the host's entire screen. Use to see part of the host's screen close up.



    Delete button

Deletes (or removes) the selected files and folders from the active drive or folder.



Dialing Properties

Settings in Windows 95 that allow you to set up calling locations and the use of calling card numbers.



Dialing location

Set up in Windows 95 so that you can have different settings for calling from different locations or for different needs.

For example, if you travel for business, you may set up different dialing locations for dialing from your office and for dialing from 
hotels.



    Connect over Dial-Up Networking button

Opens a Dial-Up Networking connection with another computer running LapLink. You connect over a modem using Windows 95 
Dial-Up Networking, and then you can connect to other computers on the network using the Connect over Network button.



Dial-up server

Can be either a Windows 95 workstation running the dial-up server supplied with Microsoft PLUS! Companion for Windows, or a 
specialized server available from other network manufacturers.



    Disconnect button

Breaks the connection with the computer you select. When a connection is broken, all its related service windows are closed.



ECP

Extended Capabilities Port. A new type of parallel port used for printing and transferring files.

DirectParallel Universal cables that are used on ECP ports transfer files up to 10 times faster than standard parallel ports.



Enable

Turns the feature on. In the case of ports, the port is available and its settings apply to new connections.



Encryption

LapLink uses a standard algorithm for transferring information securely over the Internet or a WAN (wide area network). When 
enabled, encryption is used when transferring information using Chat, File Transfer, Remote Control, and Xchange Agent.

This product contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright © 1991-2, RSA Data Security, Inc. 
Created 1991. All rights reserved.



    Open File Transfer Window button

Opens or displays a File Transfer window for the remote computer after a connection has been made. Also opens or displays a 
File Transfer window for the local computer if not connected to another computer.



File Transfer file pane

Displays the contents of the folder currently selected in the tree pane. Its contents can include subfolders as well as files. You can 
select any or all of the subfolders and files in this pane, which appears on the right side of the File Transfer window.



File Transfer tree pane

Displays drives and folders. Folders and subfolders appear as branches off the root folder. In this pane, which appears on the left 
side of a File Transfer window, you can select one drive or folder at a time.



File Transfer window

Allows you to move, copy and delete files between your computer and a remote computer. File transfer commands are located on 
the File, View, and SyncTools menus.



Filter

Displays and selects only those files with similar names or characteristics.



Folder

Contain files or subfolders. Used to organize information stored on a disk. Also called a directory in DOS and previous versions of 
Windows.



Full screen

Display the remote computer’s screen so that it fills your computer’s entire screen.



Guest

A computer that connects to and controls a remote computer (the host). A guest can use Remote Control to control many hosts at 
one time.



Host

A computer that is connected to and is controlled by a remote computer (the guest). A computer can host only one guest at any 
time.



IrDA

Windows 95 Infrared communications driver. Used to communicate using infrared ports and devices.



IPX

Network protocol. Commonly used by Novell Netware networks.



LapLink menus

Lists of commands that appear at the top of the LapLink window.

When you first open LapLink for Windows 95, these menus appear:    File, Connect, Options, Window, and Help. Whenever you 
use a different service, such as File Transfer, Remote Control, or Chat, additional menus appear.



LinkBar

Appears near the top of the LapLink window. Allows you to connect to another computer, disconnect, access your Address Book, 
change security settings, and open File Transfer, Remote Control, and Chat.



Local transfer

Moving, copying, or deleting files on your computer’s local hard or floppy drives. Can be done in one or more File Transfer 
windows.



Local File Transfer window

Allows you to move, copy and delete files between your drives and folders on your computer.



Local security

Allows you to set privileges allowed for other computers when connecting to your computer.

Can be set by clicking  on the LinkBar.



Locking privileges

Allows you to blank the host's screen and lock its mouse and keyboard. A guest must request the right to lock a host, and the host 
must grant that right to the guest before any locking can take place.



Log-in List

Stores the names of remote computers that are allowed to connect to your computer along with other settings, such as passwords.



    Connect over Modem button

Opens a modem connection with another computer running LapLink.



    Move button

Moves the selected files and folders to the target drive or folder.



    Connect over Network button

Opens an network connection with another computer running LapLink. Can also be used to open a connection over the Internet.



Pane

Section of a Chat or File Transfer window.

In Chat, the upper pane displays the ongoing conversation and the lower pane displays the text that computer intends to send to 
the other computer. In File Transfer, the file (right) pane displays the contents of the folder currently selected in the tree (left) pane.



Parallel

An interface for connecting an external device such as a printer. Most personal computers have both a parallel (LPT) port and at 
least one serial (COM) port. The parallel port uses a 25-pin connector.

With LapLink, you must use the yellow LapLink parallel cable or the newer DirectParallel Universal cable.



Password

Code or series of characters that allows you to access your LapLink settings or to connect to another computer. This password 
keeps others who from connecting or changing your LapLink settings.

Caution: Avoid using your name or phone number as your passwords.



Prefix

Number that is dialed before the phone number, often to access an outside line. Dialing prefixes are set up in Windows 95 Dialing 
Properties.



Private system

If your computer is a private system, other computers cannot connect to it using LapLink.



Public system

If your computer is a public system, any computer can connect to your computer and open File Transfer, Remote Control, and 
Chat.



    Open Remote Control Window button

Opens or displays a Remote Control window for the remote computer after a connection has been made.



Remote Control window

Allows you to control a remote computer that you are connected to.



Right click

Displays the edit menu when you click your right mouse button.



    Security button

Displays the Security dialog box, where you can set up password protection and privileges for users to access your local 
computer.



Scaled-to-fit view

Displays the remote computer’s screen so that it fits within your LapLink window.



Serial

A general-purpose interface for connecting external devices such as modems, mice and printers to the computer. Most personal 
computers have both a parallel (LPT) port and at least one serial (COM) port. The serial port uses a 25-pin or 9-pin connector.

With LapLink, you may use the blue LapLink serial cable.



Services

When you connect to another computer, you can open one or more of these LapLink services: File Transfer for transferring files, 
Remote Control for controlling remote computers, and Chat for online conversations with remote computers.



Shortcut keys

A combination of keys that you press to execute a command usually found on one of the LapLink menus. Most shortcut keys use 
either Ctrl or Alt in combination with another key. For example, Ctrl+A is used to select everything in the File Transfer or Chat 
windows. When using Remote Control, shortcut keys allow you to quickly switch between different views of the host computer.

Pre-defined shortcut keys appear on the LapLink menus.



    Sync button

Synchronizes two folders in a two-way exchange of files. Copies or moves files and folders from the source folder to the target, 
and then copies files and folders from the target to the source folder. Then, both source and target folders will contain the same 
files and folders.



Sort by Attribute button

Arranges the active file pane by attributes with folders before files.



Sort by Date/Time button

Arranges the active file pane by dates and times with folders before files.



Sort by Extension button

Arranges the active file pane by extensions with folders before files.



Sort by Name button

Arranges the active file pane by names with folders before files.



Sort by Size button

Arranges the active file pane by size with folders before files.



Source

The drive or folder where the file or folder is being transferred from.



SpeedSync

Allows you to transfer files quickly. This patented technology transfers only the differences between versions of files, instead of 
entire files.



Status line

Displays a brief description of a LinkBar button or File Transfer window button when you move your mouse over (without clicking) 
it. Also displays a brief description of menu commands.



Suffix

Number that is dialed after the phone number, usually to enter a calling card number. Dialing suffixes are set up in Windows 95 
Dialing Properties.



System file

Also called hidden file or protected file.

An essential file for operating your computer. System and hidden files are usually protected from being moved or deleted as these 
files are often needed for your computer to operate properly.



Target

The drive or folder where the file or folder is being transferred to.



TCP/IP

Transport Control Protocol/Internet Protocol

Communications protocol that you can use to connect to another computer over a network such as Novell Netware and the 
Internet.



TCP/IP address

A TCP/IP address is the computer’s Internet address, which can be a string of numbers such as 255.255.255.255, or a descriptive 
address such as janedoe.acme.com. The descriptive address is often similar, but not identical to the email address.



    Up One Level button

Moves up one level or folder at a time in the tree pane.



Windows system keys

Allows you to quickly open menus, move between programs, and display dialog boxes.

During a Remote Control session, these keys operate on either the host or guest computer.

For a list of Windows system keys in LapLink, refer to the LapLink User’s Guide.



    Connect over Wireless button

Opens a wireless connection with another computer running LapLink.

In LapLink for Windows 95, you can use these devices:
Infrared ports and devices supported by the Windows 95 Infrared communications driver (IrDA) version 1.0. You can 

download this driver from the Microsoft site on the Internet, and then install it on your computer.
Wireless devices supported without IrDA in earlier LapLink versions, including:
AirShare modules available from Traveling Software, Inc. To order, call Traveling Software.
Infrared units on the Hewlett Packard OmniBook models 430, 530, 600, and 4000.

Extended Systems JetEye Infrared PC Interface (baud-switchable only).
Hint: To use these devices without IrDA, add UseIRDADriver=No to your LLW.INI file.



Addition of Xchange agent topics



    Add Folder Pair button

Allows you to add folder pairs to the current Xchange agent.



    Close Preview button

Switches to Edit for the current Xchange agent, and closes Preview.



Conflict

Conflicts occur when you modify a file in both locations. Since both files are new, Xchange Agent requires you to decide how to 
handle them. This is called resolving conflicts.

There are two types of conflicts:
New conflicts occur when files have been changed on both computers or locations since the previous synchronization. 

The date stamp on both files is later than the date and time that the agent was last run.
Old conflicts occur when conflicts were left unresolved in earlier synchronizations, and the files are dated before the latest 

synchronization. 
This timeline demonstrates how old conflicts can occur:



 Edit mode

In Edit, you can add pairs of folders and files with arrows indicating the direction that files will be copied when the Xchange agent 
is previewed and run. You can also customize the agent’s settings.



Filter (Xchange Agent)

Selects only those files with similar names or characteristics. 

Typically these files are then included in the synchronization, and the rest of the files are not included. If the filter specifies that files 
are excluded, the rest of the files are included while the files that match the filter are not included in the synchronization.



    Left to Right Only button

Specifies that the selected folder pair will use a one-way synchronization, where files and folders from the computer or location 
shown on the left will be transferred to the computer or location shown on the right.

This illustrates what can occur when you choose Left to Right Only:



    New Xchange Agent button

Opens a blank Xchange agent window so that you can create a new Xchange agent. 



    Next Conflict button

Selects the next conflict in the previewed Xchange agent. If you just opened the preview, this command will select the first conflict 
in the list.



    Open Xchange Agent button

Opens an Xchange agent that you select from a list of previously saved Xchange Agent files. 



Preview mode

In Preview, you can see pairs of folders and files with arrows indicating the direction that files will be copied when the Xchange 
agent is run. You can also customize the agent by excluding pairs of files and folders, leaving them as they are on each computer.



    Preview Xchange Agent button

Shows how the current Xchange agent will transfer or synchronize files when it is run.

In Preview, you can see pairs of folders and files with arrows indicating the direction that files will be copied when the Xchange 
agent is run. You can also customize the agent by excluding pairs of files and folders, leaving them as they are on each computer.



    Resolve Conflict button

Prompts you to specify how you want to resolve the selected conflict for the current synchronization. Conflicts appear when you 
preview or run an Xchange agent to allow you to decide how you want to handle each conflict.



    Right to Left Only button

Specifies that the selected folder pair will use a one-way synchronization, where files and folders from the computer or location 
shown on the right will be transferred to the computer or location shown on the left. 

This illustrates what can occur when you choose Right to Left Only:



    Run Xchange Agent button

Runs the selected or current Xchange agent.



    Save Xchange Agent button

Saves the Xchange agent’s current settings using its current file name. If the file is not yet saved, saves the current Xchange 
agent’s settings in a new file.



    Skip Pair(s) button

Omits the selected files or folders from the next synchronization. Skipping a folder also omits all the files and subfolders that it 
contains from the synchronization.



Status line (Xchange Agent)

Displays a brief description of an Xchange Agent toolbar button or menu command when you move your mouse over (without 
clicking) it. Also displays whether you are using Edit or Preview mode (as shown in the far right of the status line).

In Preview, also displays the number of files, the size of the files, and the number of conflicts in the current synchronization.



    Synchronize Both Directions button

Specifies that the selected folder pair will use a two-way synchronization. New files and folders are copied to and overwrite older 
files on the other computer. 

This illustrates what can occur when you choose Synchronize Both Directions:



Toolbar

Appears near the top of the Xchange Agent window. Contains buttons for quick access to commonly used commands, and 
changes when you switch between Edit or Preview.

Edit toolbar

Preview toolbar



    Undo Skip Pair(s) button

Reverses a previous command to omit the selected files or folders from the synchronization. The selected files and folders will now 
be included in the synchronization.



Xchange Agent menus

Lists of commands that appear at the top of the Xchange Agent window.

When you first open Xchange Agent, these menus appear:    File, Edit, Preview, Options, and Help. Available options vary when 
you switch from Edit to Preview.





What’s New in LapLink for Windows 95, version 7.5
 Quick Steps

Synchronizing files using Xchange Agent:
With a single click, Xchange Agents automatically connects and synchronizes one or many 

files and folders between two computers.
The Xchange Agent wizard simplifies the process of setting up your own Xchange agents.
Safely exchange multiple versions of the same file using smart conflict resolution.
Use Preview prior to synchronizing files to see which files will be copied and to make last-

minute changes.
Schedule Xchange agents to run in your absence, in combination with the Microsoft System 

Agent included with Microsoft Plus!
Make a Windows desktop shortcut for any Xchange agent that you create. Then, you can 

simply double-click its icon to run the agent.

Transferring files:
Choose whether to use the Windows 95 Recycle Bin when files are deleted.
If a file transfer is interrupted because the connection breaks accidentally, you can reconnect 

and continue the transfer where you left off. You don’t have to transfer the entire file again.
Encryption protects your files and information during file transfer, remote control, and remote 

node sessions.

Controlling another computer:
Decrease the number of bitmap colors transferred from the remote computer to your computer 

to increase Remote Control performance.
Filter out large bitmaps, such as program splash screens, so that they don’t slow a Remote 

Control session.
Stores images of the remote computer’s screen for future connections. This speeds up 

Remote Control by restoring your view of the remote computer from your hard disk rather than over 
the connection.

Match computer resolutions on the fly when connecting to a desktop computer from a laptop 
computer. Once the screen resolutions are the same, you can view the entire host screen at once.

Share clipboard information with remote computers.

Connecting to another computer:
Save connections by name to restore a specific connection either manually or when you begin 

a new LapLink session.
Make a Windows desktop shortcut for any connection that you save. Then, you can simply 

double-click its icon to restore the connection.



Xchange Agent commands and dialog boxes
 Xchange Agent shortcut keys
 LapLink commands

Choose commands with the menu bar, toolbar, and shortcut keys. All commands are accessible through the 
menus. Many commands have keyboard and toolbar equivalents. Commands and menus are available depending 
on the mode you are using: Edit or Preview.

A

About Xchange Agent

Add Filter dialog box

Add Folder Pair

B

C

Choose a connection dialog box

Choose folders to synchronize dialog box

Close Preview

Close

Create Desktop Shortcut

D

Delete Pair(s)

E, F, G

H

Help Topics

I, J, K



L

Left to Right Only

M

N

New Xchange Agent

Next Conflict

O

Open Xchange Agent

P

Preview Xchange Agent

Properties

Properties for New Agents

Q

Quick Steps

R

Resolve Conflict

Resolve File Conflict dialog box

Resolve Folder Conflict dialog box

Resolve LFN Conflict dialog box

Right to Left Only

Run Xchange Agent

S

Save Xchange Agent As

Save Xchange Agent

Schedule

Select All

Set Filter

Skip Pair(s)

Status Line

Synchronize Both Directions

T

Toolbar

U

Undo Skip Pair(s)

V, W



X

Xchange Agent Wizard

Y, Z



New Xchange Agent command
 Quick Steps 
 Related Topics 
 Tips

Opens a blank Xchange Agent window so that you can create a new Xchange agent. 

To set up the synchronization, use the Add Folder Pair command or drag folders from the File Transfer windows to 
each side of the Xchange Agent window.

If you select this command in LapLink, a separate Xchange Agent window opens. If you are choosing this 
command from an open Xchange Agent window, this command opens a blank Xchange Agent window.



Open Xchange Agent command
 Quick Steps 
 Related Topics 
 Tips

Opens an Xchange agent that you select from a list of previously saved Xchange Agent files. 

If you select this command in LapLink, a separate Xchange Agent window opens. If you are choosing this 
command from an open Xchange Agent window, the selected Xchange agent opens in that window. 

Option Description

Look in Specifies the folder where Xchange Agent files are saved, which is by default 
\tsi32\data in the Windows installation folder. 

File name Type the name or a description of the Xchange agent. This name will be the 
file name for the saved agent.

To select a file name from the list box, click it and its name appears here.

Files of type Specifies that you are looking for a Xchange Agent File, and that the file name 
extension will be .LLX.

Open Click this to open the Xchange agent file selected in File name, and close this 
dialog box.

Cancel Click this to close this dialog box.

Run Xchange Agent command
 Quick Steps 
 Related Topics 
 Tips

Runs the selected or current Xchange agent.

If you select this command in LapLink, you must first select the Xchange agent in the Open dialog box, and then a 
separate Xchange Agent window automatically opens and the Xchange agent is run using its saved settings. If 
you are choosing this command from an open Xchange Agent window, this command runs the agent using its 
current settings. If necessary, LapLink connects your computer to the computer or computers specified in the 
Xchange agent.

Hint: What happens when you run an Xchange agent depends on the agent’s Properties. By default, the agent 
will first preview before running. To change run options for the agent, click Properties on the File menu.



Xchange Agent Wizard command
 Quick Steps 
 Related Topics 
 Tips

Creates a new Xchange agent by leading you through the main steps in creating an agent: 

Opening a new Xchange agent window
Choosing a connection, adding folder pairs
Saving the Xchange agent
Previewing or editing the Xchange agent

If you select this command in LapLink, the Xchange Agent Wizard is run. If you already have an Xchange agent 
open, this command runs the Xchange Agent Wizard and opens the new agent that you create in a separate 
window.



Save Xchange Agent command
 Quick Steps 
 Related Topics 
 Tips

Saves the Xchange agent’s current settings using its current file name. If the file is not yet saved, saves the 
current Xchange agent’s settings in a new file.

This is an Xchange Agent File (.LLX) and is saved by default in the \tsi32\data folder in the Windows installation 
folder. After you save the file, you can then open or run the Xchange agent at any time or schedule the file to run 
at a specific time.



Save Xchange Agent As command
 Quick Steps 
 Related Topics 
 Tips

Saves the current Xchange agent’s settings using a new file name. 

This is an Xchange Agent File (.LLX) and is saved by default in the \tsi32\data folder in the Windows installation 
folder. After you save the file, you can then open or run the Xchange agent at any time or schedule the file to run 
at a specific time.

Option Description

Save in Specifies the folder where Xchange agents are saved, which is by default the 
\tsi32\data folder in the Windows installation folder. 

File name Type the name or a description of the Xchange agent. This name will be the 
file name for the saved agent.

To replace an existing agent’s file, click its name in the list and its name 
appears here.

Files of type Specifies that this is an Xchange Agent File, and that the file name extension 
will be .LLX.

Save Click this to save the Xchange agent using the specified file name, and close 
this dialog box.

Cancel Click this to close this dialog box without saving the Xchange agent.

Create Desktop Shortcut command
 Quick Steps 
 Related Topics 
 Tips

Puts a shortcut icon for the current Xchange agent on your Windows desktop. You can then double-click this 
shortcut at any time to run the Xchange agent. If LapLink is not running, LapLink will open, and the agent will open 
and run using its saved settings.

You can also right click this shortcut, and then choose to open, edit, or preview the Xchange agent.

Caution: To avoid unintended consequences in running an agent from a shortcut, open the agent and then click 
Properties on the File menu to check its settings.



Schedule command
 Quick Steps
 Related Topics
 Tips

Schedules the current Xchange agent to run unattended. For the agent to run automatically, your computer and 
the Microsoft System Agent must be running at the date and time specified in this dialog box. 

Hint: When scheduled, an Xchange agent runs in unattended mode even if you have a different setting in its 
Properties. By default, all conflicts are ignored and the files are not transferred.

You can use other schedulers and personal information managers (PIMs) besides Microsoft System Agent. To do 
this, add the following to your scheduler’s command line:

c:\laplink\laplink.exe /s c:\windows\tsi32\data\myagent.llx

where c:\laplink\laplink.exe is the full path to the LapLink program, /s specifies that you’re using that scheduler to 
run the Xchange agent unattended, and c:\windows\tsi32\data\myagent.llx is the full path to the Xchange agent 
file that you want to run (in this case, myagent.llx).

Option Description

Schedule job at Specifies the time that the Xchange agent will run. You must also specify the 
frequency below.

To change the time, click the hour, minutes, and AM/PM boxes, and then click the 
arrows. You can also type the time directly in each box.

Once on Click this to specify the only date when the current Xchange agent will run. You 
must also specify the time in the Schedule job at boxes.

To change the date, click the month, day, and year boxes, and then click the 
arrows. You can also type the date directly in each box.

Daily Click this to specify that the current Xchange agent will run every day. You must 
also specify the time of day in the Schedule job at boxes.

Weekly, on Click this to specify the days of the week when the current Xchange agent will run. 
You must also specify the time of day in the Schedule job at boxes.

You can select as many days as you wish.

Monthly, on the Click this to specify when the current Xchange agent will run each month. You 
must also specify the time in the Schedule job at boxes.

To change the date, click the arrows or type the date.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Properties command
 Quick Steps
 Related Topics
 Tips

Set options to determine how the open or currently selected Xchange agent synchronizes files and folders.

To view information about the open Xchange agent, click the General tab. To set options for the way that the 
current agent will run, click the Run Options tab. To specify the types of files to include in the current agent, click 
the File Options tab. To specify how you want to handle old conflicts for the current agent, click the Advanced tab.



Tab Option Description

General tab Name Specifies the file name and location of the current 
Xchange agent.

Computers Specifies the names of the computers specified in the 
current Xchange agent, and the type of connection used 
between these computers.

Last Run Specifies whether and when the current Xchange agent 
were last run.

Created Specifies when the current Xchange agent was created.

Run Options 
tab

Preview before 
running

Click this to preview the current Xchange agent before 
synchronizing the files.

Run with 
confirmations, 
without 
previewing first

Click this to run the current Xchange agent without 
previewing the synchronization. If any conflicts occur, 
you will be asked to confirm how you want each conflict 
handled before the Xchange agent completes the 
synchronization.

Run unattended, 
without preview 
or confirmations

Click this to run and complete the current Xchange agent 
without previewing the synchronization or being asked to 
confirm how you want each conflict handled.

Select how you want all conflicts handled using the 
options below.

If conflicts are 
encountered

Click Do not copy either; keep both files if you 
want Xchange Agent to keep both files and not 
synchronize them. You will not be asked to resolve the 
conflict.

Click Copy the newer file over the older if you 
want to keep the most recent file. The file with the most 
recent date stamp will be saved in both folders, replacing 
the older file. You will not be asked to resolve the conflict.

Hint: Scheduled agents, by default, skip all conflicts 
unless you run a scheduled agent with this setting.

File Options 
tab

Include 
Subfolders

If checked, subfolders in any folder selected in the 
current Xchange agent are synchronized.

Include Read-
only files

If checked, all read-only files in any folder selected in the 
current Xchange agent are synchronized.

Include Hidden 
files

If checked, all hidden files in any folder selected in the 
current Xchange agent are synchronized.

Include System 
files

If checked, all system files in any folder selected in the 
current Xchange agent are synchronized.

Include files only 
if they are 
present in both 
folders

If checked, files and subfolders are synchronized only 
when the same file or folder name is located in both 
folders in the current Xchange agent’s folder pair. Any file 
or subfolder that does not exist in the other folder is not 
transferred to the other folder and remains in its original 
location.

Advanced tab Include 
previously 
skipped files

Click this to include old conflicts that have been 
previously skipped.

Hint: If you include these old conflicts, they are then 
handled like new conflicts using the settings on the Run 



Options tab.

Exclude 
previously 
skipped files

Click this to exclude old conflicts that have been 
previously skipped.

The files will not be synchronized, and you will not be 
asked to resolve the conflicts.

Defaults Click this to restore the original settings.

OK Click this to close this dialog box and save any changes 
you made.

Cancel Click this to close this dialog box without saving any 
changes you made.

Apply Click this to save any changes you made without closing 
this dialog box.

Help Click this to display an overview of this dialog box.

Close command (Xchange Agent only)
 Quick Steps 
 Related Topics 
 Tips

Closes the current Xchange agent, and closes the Xchange Agent window. If you have unsaved changes for the 
current Xchange agent, you will be prompted to save them. LapLink remains open.



Add Folder Pair command
 Quick Steps 
 Related Topics 
 Tips

Allows you to add folder pairs to the current Xchange agent.

Option Description

Left window pane Click the folder that you want to synchronize so that its name appears below. You 
must also specify the folder that you want to synchronize with this folder using the 
right window pane.

To find a folder, click + to open a drive or folder.

Right window 
pane

Click the folder that you want to synchronize so that its name appears below. You 
must also specify the folder that you want to synchronize with this folder using the 
left window pane.

To find a folder, click + to open a drive or folder.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Choose a connection dialog box
 Quick Steps 
 Related Topics 
 Tips

Before adding folder pairs to the Xchange agent, you must select the connection you are using and, if a remote 
connection, the computer you are connecting to.

Hint: This dialog box appears when a connection is not yet specified for the Xchange agent. Names of 
connections appear under the toolbar.

Option Description

Local-Local Click this to synchronize files and folders only on your local computer.

Local-Remote Click this to synchronize files and folders between your computer and another 
computer. Then, select the computer that you want to use for this Xchange agent 
connection from the list below. 

Hint: You must be connected to the computer so that it appears in this list.

Connection list Specifies the computers that you are currently connected to. If you selected Local-
Remote, click the computer that you want to connect to.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Delete Pair(s) command
 Quick Steps 
 Related Topics 
 Tips

Removes the selected folder pair or pairs from the current Xchange agent.



Synchronize Both Directions command
 Quick Steps 
 Related Topics 
 Tips

Specifies that the selected folder pair will use a two-way synchronization. New files and folders are copied to the 
other computer. Newer files on the left computer will be copied to and overwrite older files on the right computer. 
Newer files on the right computer will be copied to and overwrite older files on the left computer.

Click here for an example of using Synchronize Both Directions    . Or you can use Right to Left Only or Left to 
Right Only.



Left to Right Only command
 Quick Steps 
 Related Topics 
 Tips

Specifies that the selected folder pair will use a one-way synchronization, where files and folders from the 
computer or location shown on the left will be transferred to the computer or location shown on the right. Files and 
folders are copied in one direction only so that only one folder updates the other. No files or folders are copied 
from the right computer to the left computer.

Click here for an example of using Left to Right Only    . Or you can use Right to Left Only or Synchronize Both 
Directions.



Right to Left Only command
 Quick Steps 
 Related Topics 
 Tips

Specifies that the selected folder pair will use a one-way synchronization, where files and folders from the 
computer or location shown on the right will be transferred to the computer or location shown on the left. Files and 
folders are copied in one direction only so that only one folder updates the other. No files or folders are copied 
from the left computer to the right computer.

Click here for an example of using Right to Left Only    . Or you can use Left to Right Only or Synchronize Both 
Directions.



Set Filter command
 Quick Steps 
 Related Topics 
 Tips

Specifies which files will be included or excluded in the transfer when the selected folder pair is synchronized. 

Initial filters listed are for widely used file types, using file name extensions for commonly used Windows 95 
applications.

Hint: If you want to synchronize a single file, create a new filter for that file name, and then apply it to the folder 
pair.

Option Description

Available filters Lists the filters that are currently available in LapLink.

To apply a filter to the selected folder pair, click its name and then click Add. To 
create a new filter, click New.

Active filters Lists the filters that are selected for and apply to the selected folder pair.

To add a filter to this list, click its name in the Available filters list and then click Add. 
To remove a filter from this list, click its name and then click Remove.

Add Click this to add the filter selected in the Available filters list to the Active filters list. 
This filter will apply to the selected folder pair.

Remove Click this to remove the selected filter from the Active filters list.

New Click this to create a new filter. New filters are added to the Available filters list.

Edit Click this to change the filter selected in the Available filters list.

Hint: Changes you make to a filter do not apply to filters you have selected 
previously for existing folder pairs.

Delete Click this to remove the filter selected from the Available filters list.

Hint: Filters that are deleted from this list are not deleted from existing folder pairs.

Exclude files that 
match these 
filters

If checked, the filter is reversed: file names and types that are specified in the 
selected filters are not included, and all other file names and types are included, in 
the synchronization.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Add Filter dialog box
 Quick Steps 
 Related Topics 
 Tips

Adds a filter to the Available Filters list in the Set Filter dialog box.

If you use wildcards, you can filter by file type (using file name extensions) or name combinations. You can also 
filter specific files by specifying complete file names, including extensions.

Option Description

Filter Name Type a name for the filter, which will appear in the Available filters list in the Set Filter 



dialog box.

This filter can be selected for the current Xchange agent, or applied to future or 
previously saved Xchange agents.

Pattern(s) Type the criteria for file names that you want included when the folder pair is 
synchronized.

You can use wildcards (for example:    win?.*,    *.exe, *.ini), or an entire file name 
(win.ini). You can specify several criteria by inserting ; (a semicolon) between them.

OK Click this to close this dialog box and save any changes you made.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Select All command (Xchange Agent only)
 Quick Steps 
 Related Topics 
 Tips

In Edit, selects all folder pairs in the current Xchange Agent. In Preview, selects all file and folder pairs for the 
current synchronization.



Preview Xchange Agent command
 Quick Steps 
 Related Topics 
 Tips

Shows how the current Xchange agent will transfer or synchronize files when it is run.

In Preview, you can see pairs of folders and files with arrows indicating the direction that files will be copied when 
the Xchange agent is run. You can also customize the agent by excluding pairs of files and folders, leaving them 
as they are on each computer.



Resolve Conflict command
 Quick Steps 
 Related Topics 
 Tips

Prompts you to specify how you want to resolve the selected conflict for the current synchronization. Conflicts 
appear when you preview or run an Xchange agent to allow you to decide how you want to handle each conflict.

If you skip a conflict, you carry it over to future synchronizations; this choice may produce both new conflicts and 
old conflicts in future synchronizations.



Resolve File Conflict dialog box
 Quick Steps 
 Related Topics
 Tips

Prompts you to specify how you want to resolve the selected conflict.

Option Description

Job was last run 
at

Specifies the date and time that the current Xchange agent was last run.

Left Computer Specifies the following information about one of the computers in the Xchange 
agent’s connection:

Name of the computer
Name of the file that conflicts with a file of the same name on the other 

computer
Date that the file was last saved
Size of the file

Right Computer Specifies the following information about the other computer in the Xchange agent’s 
connection:

Name of the computer
Name of the file that conflicts with a file of the same name on the other 

computer
Date that the file was last saved
Size of the file

Copy Newer File Click this if you want to copy the most recently saved file to the other folder. The file 
with the most recent date stamp will be saved in both folders.

If you want to keep the file with the oldest date stamp in its original folder, click 
Rename new file so that it is checked and then type its new file name in the New 
name box. The newer file will be saved to the other folder using the file name in the 
New name box, and the older file will retain its file name.

Copy Older File Click this if you want to copy the older file to the other folder. The file with the 
earliest date stamp will be saved in both folders.

If you want to keep the file with the most recent date stamp in its original folder, click 
Rename old file so that it is checked and then type its new file name in the New 
name box. The older file will be saved to the other folder using the file name in the 
New name box, and the newer file will retain its file name.

Skip this pair. Do 
not copy either 
file.

Click this if you want to exclude this folder pair from the synchronization. Each file 
will stay in their original folders, and they will not be synchronized.

Hint: If you run this Xchange agent again after selecting this option, you may 
encounter an old conflict. Your selections in the Advanced tab of the Properties 
dialog box apply to old conflicts.

OK Click this to close this dialog box and save any changes you made.

Next Click this to view the next conflict.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Resolve Folder Conflict dialog box
 Quick Steps 
 Related Topics



 Tips

Prompts you to specify how you want the selected conflict resolved. Conflicts occur between files and folders 
when they have exactly the same name, including extensions.

Option Description

Computer Specifies the following information about the computer where the conflict between a 
file and folder occurred in the Xchange agent’s connection:

Name of the computer
Name of the file (or folder) that conflicts with a folder (or file) of the same 

name on the other computer
Date that the file or folder was last saved
Size of the file or folder

Rename and copy Click this if you want to rename the file (or folder) so that it is not the same as the 
folder (or file) on the other computer. In the box, type its new name.

The file (or folder) will be saved on the target using its new name, leaving the 
original file (or folder) in its original location.

Skip this pair. Do 
not copy either 
file.

Click this if you want to exclude this folder pair from the synchronization. The file 
and folder will stay in their original folders, and they will not be synchronized.

Hint: If you run this Xchange agent again after selecting this option, you may 
encounter an old conflict. Your selections in the Advanced tab of the Properties 
dialog box apply to old conflicts.

OK Click this to close this dialog box and save any changes you made.

Next Click this to view the next conflict.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Resolve LFN Conflict dialog box
 Quick Steps 
 Related Topics
 Tips

Prompts you to specify how you want to resolve conflicts that occur when synchronizing files from a drive that 
allows both long and short file names to a drive that allows only short file names. 

Option Description

Computer Specifies the following information about the computer where the long file name is 
located when synchronizing files to a drive that allows only short file names in the 
Xchange agent’s connection:

Name of the computer
Name of the file that uses a long file name
Date that the file was last saved
Size of the file

Rename and copy Click this if you want to rename the file so that it uses a short file name. In the box, 
type a new file name, using a short (DOS) file name. You are limited to eight 
characters plus a three-character extension. 

The file will be saved on the target using its new file name, leaving the original file 
with the long file name in its original location.

Skip this pair. Do 
not copy either 
file.

Click this if you want to exclude this folder pair from the synchronization. The file will 
stay in its original folder, and will not be copied to the other folder.



Hint: If you run this Xchange agent again after selecting this option, you may 
encounter an old conflict. Your selections in the Advanced tab of the Properties 
dialog box apply to old conflicts.

OK Click this to close this dialog box and save any changes you made.

Next Click this to view the next conflict.

Cancel Click this to close this dialog box without saving any changes you made.

Help Click this to display an overview of this dialog box.

Next Conflict command
 Quick Steps 
 Related Topics 
 Tips

Selects the next conflict in the previewed Xchange agent. If you just opened the preview, this command will select 
the first conflict in the list.



Skip Pair(s) command
 Quick Steps 
 Related Topics 
 Tips

Omits the selected files or folders from the synchronization. Skipping a folder also omits all the files and 
subfolders that it contains from the synchronization.

Hint: If you make changes in Preview, run the agent before closing Preview.



Undo Skip Pair(s) command
 Quick Steps 
 Related Topics 
 Tips

Reverses a previous command to omit the selected files or folders from the synchronization. The selected files 
and folders will now be included in the synchronization.

Hint: If you make changes in Preview, run the agent before closing Preview.



Close Preview command
 Quick Steps 
 Related Topics 
 Tips

Switches to Edit for the current Xchange agent, and closes Preview.

Hint: If you make changes in Preview, run the agent before closing Preview.



Properties for New Agents command
 Quick Steps
 Related Topics
 Tips

Set options to determine how all Xchange agents created in the future will, by default, synchronize files and 
folders.

To set options for the way agents will run, click the Run Options tab. To specify the types of files to include in 
agents, click the File Options tab. To specify how you want to handle old conflicts, click the Advanced tab.

Hint: This command changes default settings that are used when you create new agents. To change settings for 
the currently open Xchange agent, click Properties on the File menu.

Tab Option Description

Run Options 
tab

Preview before 
running

Click this to preview Xchange agents before 
synchronizing the files.

Run with 
confirmations, 
without 
previewing first

Click this to run Xchange agents without previewing the 
synchronization. If any conflicts occur, you will be asked 
to confirm how you want each conflict handled before the 
Xchange agent completes the synchronization.

Run unattended, 
without preview 
or confirmations

Click this to run and complete Xchange agents without 
previewing the synchronization or being asked to confirm 
how you want each conflict handled.

Select how you want Xchange Agent to handle all 
conflicts using the options below.

If conflicts are 
encountered

Click Do not copy either; keep both files if you 
want Xchange Agent to keep both files and not 
synchronize them. The files will stay in the same 
location. You will not be asked to resolve the conflict.

Click Copy the newer file over the older if you 
want to keep the most recent file. The file with the most 
recent date stamp will be saved, replacing the older file. 
You will not be asked to resolve the conflict. 

Hint: Scheduled agents, by default, skip all conflicts 
unless you run a scheduled agent with this setting.

File Options 
tab

Include 
Subfolders

If checked, subfolders in any folder selected in an 
Xchange agent are synchronized.

Include Read-
only files

If checked, all read-only files in any folder selected in an 
Xchange agent are synchronized.

Include Hidden 
files

If checked, all hidden files in any folder selected in an 
Xchange agent are synchronized.

Include System 
files

If checked, all system files in any folder selected in an 
Xchange agent are synchronized.

Include files only 
if they are 
present in both 
folders

If checked, files and subfolders are synchronized only 
when the same file or folder name is located in both 
folders in the Xchange agent’s folder pair. Any file or 
subfolder that does not exist in the other folder is not 
transferred to the other folder and remains in its original 
location.

Advanced tab Include 
previously 
skipped files

Click this to include old conflicts that have been 
previously skipped.



Hint: If you include these old conflicts, they are then 
handled like new conflicts using the settings on the Run 
Options tab.

Exclude 
previously 
skipped files

Click this to exclude old conflicts that have been 
previously skipped.

The files will not be synchronized, and you will not be 
asked to resolve the conflicts.

Defaults Click this to restore the original settings.

OK Click this to close this dialog box and save any changes 
you made.

Cancel Click this to close this dialog box without saving any 
changes you made.

Apply Click this to save any changes you made without closing 
this dialog box.

Help Click this to display an overview of this dialog box.

Status Line command (Xchange Agent only)
 Quick Steps
 Related Topics
 Tips

Displays or hides the status line, which is at the bottom of the active Xchange Agent window. When the status line 
is displayed, the command has a check mark next to it.

The status line displays the following information:

Whether you are using Edit or Preview mode (as shown in the far right of the status line)
If you are in Preview, the number of files, the size of the files, and the number of conflicts.
A brief description of a toolbar button or menu command when you move your mouse over (without clicking) 

it.



Toolbar command
 Quick Steps
 Related Topics
 Tips

Displays or hides the Xchange Agent toolbar. The toolbar contains buttons for quick access to commonly used 
commands, and changes when you switch between Edit and Preview.

Edit toolbar

Preview toolbar
When displayed, the toolbar appears below the menu bar, and a check mark appears next to the command on the 
Options Menu. When the toolbar is hidden, there is no check mark.



About Xchange Agent command
 Quick Steps
 Related Topics

Displays information about LapLink’s Xchange Agent, including version and copyrights.



Xchange Agent shortcut keys
 Xchange Agent commands
 LapLink shortcut keys

Many commands have shortcut keys. Press these keys or combinations of keys to quickly choose commands.

Click a command to view more information.

Command Shortcut keys

                   New 
Xchange Agent

Ctrl+N

Open Xchange Agent Ctrl+O

Save Xchange Agent Ctrl+S

Delete Pair(s) Delete

Select All Ctrl+A

Next Conflict F3

Undo Skip Pair(s) Ctrl+Z



Tips for New Xchange Agent command

Ö Press Ctrl+N to quickly open a new Xchange Agent window.

Ö Use this command when you do not need the wizard to guide you through setting up an Xchange agent.

Ö Before selecting this command, connect to the computer that you want to exchange or synchronize files with.

Ö Use local-to-local connections to synchronize files on your computer’s drives and any network drives that you can access.

Ö You can drag folders from the File Transfer window to the Xchange Agent window.

Ö After you create the Xchange agent, follow these steps to complete it: save the agent, preview the agent, resolve conflicts, 
verify that the synchronization is correct, and then run the agent.



Tips for Open Xchange Agent command

Ö Press Ctrl+O to quickly open an Xchange agent.

Ö Right-click an Xchange agent’s desktop shortcut , and then click Open to quickly open an agent.
Ö After opening an Xchange agent, follow these steps to complete the synchronization: preview the agent, resolve conflicts, 
verify that the synchronization is correct, and then run the agent.
Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Run Xchange Agent command

Ö Double-click an Xchange agent’s desktop shortcut     to quickly run an agent.
Ö You can also run an agent by scheduling it. Click Schedule on the File menu.
Ö Preview the Xchange agent before running it to avoid unintended consequences such as overwriting files that you want to 
keep.
Ö If a connection is interrupted while running the agent, simply rerun the agent. If you have enabled File Transfer Recovery 
in LapLink, the agent will start from where it ended instead of from the beginning.

Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.

Ö For a record of any Xchange agent synchronizations, click the LapLink window and then click Logging on the Options menu.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Xchange Agent Wizard command

Ö Before selecting this command, connect to the computer that you want to exchange or synchronize files with.

Ö You can also create Xchange agents for synchronizing files locally, when you are not connected to another computer. Local 
connections can use your computer’s drives and any network drives that you can access.

Ö To synchronize data on two remote computers (not including your local computer), you must connect to both computers, click 
the New Xchange Agent command, and then drag folders from the File Transfer windows to each side of the Xchange Agent 
window.



Tips for Save Xchange Agent command

Ö If you want a shortcut for this Xchange agent to appear on your Windows 95 desktop, click Create Desktop Shortcut on the 
File menu after you save the agent file.

Ö You must be in Edit to save the agent. If in Preview, click     on the toolbar. 
Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Save Xchange Agent As command

Ö If you want a shortcut for this Xchange agent to appear on your Windows 95 desktop, click Create Desktop Shortcut on the 
File menu after you save the agent file.

Ö You must be in Edit to save the agent. If in Preview, click     on the toolbar. 
Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Create Desktop Shortcut command

Ö Shortcuts give you a quick way to run, open, or preview an Xchange agent. Create desktop shortcuts for those Xchange 
agents that you use regularly.

Ö Shortcut icons for Xchange agents are found on the Windows desktop (main screen) and look like this: 
Ö When you create a shortcut, the Xchange agent file stays in the same folder which is, by default, \tsi32\data in the 
Windows installation folder. Your shortcut tells Windows to open that file, saving you time in locating it yourself. 

Ö Deleting a shortcut from the Windows desktop will not delete your Xchange agent file.

Ö Shortcuts can also be located using Windows Explorer or LapLink, and are saved by default to the \Desktop folder in the 
Windows installation folder.



Tips for Properties command

Ö Instead of changing settings in the Properties dialog box every time you create an agent, you can set default options for any 
future agent that you create. Click Properties for New Agents on the Options menu.

Ö These File Transfer settings, which are found in the File Transfer Options dialog box, also apply to an Xchange agent: Enable 
File Transfer Recovery on the Copy/Move tab, Use Compression on the Performance tab, and Use SpeedSync on the 
Performance tab.

Ö By default, new and old conflicts are handled the same way. To change how old (previously skipped) conflicts are handled, 
click the Advanced tab.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Schedule command

Ö To schedule an Xchange agent, Microsoft System Agent must be running on your computer. If System Agent is not installed, 
run the setup for Microsoft Plus!

Ö Use Microsoft System Agent to reschedule, temporarily disable, or remove the schedule for an agent.

Ö If the agent connects to a remote computer, create an entry for that computer in your LapLink Address Book. Include the log-
in name and password required by the remote computer to open the connection.

Ö To avoid losing data, Xchange Agent will not run the agent if it is open when it is scheduled to run.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Close command

Ö Press Alt+F4 to quickly exit Xchange Agent.

Ö LapLink remains active until you exit LapLink by clicking Exit on the File menu.



Tips for Add Folder Pair command

Ö Instead of using this command, you can select folders to be synchronized by dragging them from the File Transfer window to 
the Xchange Agent window.

Ö Xchange Agent does not merge the contents of files. To merge databases or other shared files, use the program the files 
were created in.

Ö You must be in Edit to add folder pairs. If in Preview, click        on the toolbar. 
Ö To quickly add a folder pair to the current Xchange agent, while in Edit, right-click and then click Add Folder Pair.

Ö By default, hidden files and system files are not included in synchronizations. To include them, click Properties on the File 
menu.

Ö To synchronize a single file, create a filter to specify the name of the file.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Choose a connection dialog box

Ö This dialog box opens when adding the first folder pair. Once the connection is selected and that pair is added, the computers 
for that agent cannot be changed.

Ö You can also create Xchange agents for synchronizing files locally, when you are not connected to another computer. Local 
connections can use your computer’s drives and any network drives that you can access.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Delete Pair(s) command

Ö To reinstate a deleted folder pair, click  and then reselect the folder pair.

Ö You must be in Edit to delete folder pairs. If in Preview, click        on the toolbar. 
Ö To quickly remove the selected folder pair from the current Xchange agent ,while in Edit, right-click and then click Delete 
Pair(s).
Ö You can delete more than one pair at a time. To delete all folder pairs, first click Select All in the Edit menu. To select two 
or more of the folder pairs, press Ctrl while you click each folder pair.



Tips for Synchronize Both Directions command

Ö By default, all new folder pairs use this setting.

Ö For complete synchronization, leave Synchronize Both Directions on. Use Left to Right Only or Right to Left Only for single 
direction copies only.

Ö To quickly set the direction for the selected folder pair, while in Edit, right-click and then click Synchronize Both Directions.

Ö In most cases, you do not need to change this setting. Xchange Agent never deletes files and, by default, an older file never 
overwrites a newer file.



Tips for Left to Right Only command

Ö By default, all new folder pairs use the Synchronize Both Directions setting.

Ö For complete synchronization, leave Synchronize Both Directions on. Use Left to Right Only or Right to Left Only for single 
direction copies only.

Ö To quickly set the direction for the selected folder pair, while in Edit, right-click and then click Left to Right Only.

Ö Xchange Agent never deletes files and, by default, an older file never overwrites a newer file.



Tips for Right to Left Only command

Ö By default, all new folder pairs use the Synchronize Both Directions setting.

Ö For complete synchronization, leave Synchronize Both Directions on. Use Left to Right Only or Right to Left Only for single 
direction copies only.

Ö To quickly set the direction for the selected folder pair, while in Edit, right-click and then click Right to Left Only.

Ö Xchange Agent never deletes files and, by default, an older file never overwrites a newer file.



Tips for Set Filter command

Ö To quickly select filters for the selected folder pairs, while in Edit, right-click and then click Set Filter.

Ö By default, hidden files and system files are not included in synchronizations. To include them, click Properties on the File 
menu.

Ö To synchronize a single file, create a filter to specify the name of the file. To do this, click New, and then type the complete file 
name and extension in the Pattern(s) box.

Ö If you modify any filter that you have selected for this agent or previously created agents, you must reapply the filter to apply 
the changes. Select it in Available filters, and then click Add.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Add Filter dialog box

Ö Wildcards allow you to select files with similar names. For example:

*.doc selects all files that end in .doc (usually used for file name extensions)

win*.* selects all files that start with win and include any extension

my??? selects all files with only five letters that also begin with my

myfile.llx selects only those files with that exact name

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Select All command

Ö Press Ctrl+A to quickly select all folder pairs for the current Xchange agent.

Ö To quickly select all folder pairs for the current Xchange agent, while in Edit and Preview, right-click and then click Select All.



Tips for Preview Xchange Agent command

Ö By default, Xchange agents are previewed before being run. To waive previewing a particular agent, open the agent, click 
Properties on the File menu, and then specify how you want to run this agent on the Run Options tab.

Ö Right-click an Xchange agent’s desktop shortcut , and then click Preview to quickly preview an agent. If necessary, 
LapLink connects your computer to the computer or computers specified in the Xchange agent.

Ö In Preview, arrows indicate the direction that files will be copied and which files will be overwritten.

Ö In Preview,  indicates that there is a conflict between the files or folders and 

 indicates that you are attempting to transfer long file names to a drive or computer that accepts short file names only. To resolve 
the conflict, click the file or folder pair, and then click 

    on the toolbar.
Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.



Tips for Resolve Conflict command

Ö To quickly resolve the selected conflict, while in Preview, right-click and then click Resolve Conflict.

Ö To locate a conflict, click        on the toolbar.
Ö The status line, located at the bottom of the Preview window, tells you how many conflicts have been identified.
Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.
Ö By default, each conflict is presented for you to resolve when you run an agent. To have Xchange Agent resolve conflicts 
automatically, click Properties on the File menu.



Tips for Resolve File Conflict dialog box

Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.

Ö By default, each conflict is presented for you to resolve when you run an agent. To have Xchange Agent resolve conflicts 
automatically, click Properties on the File menu.

Ö In Preview,  indicates that there is a conflict between the files. To resolve the conflict, click the file or folder pair, and then 
click 

    on the toolbar.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Resolve Folder Conflict dialog box

Ö This type of conflict usually occurs in one of the following situations: the file name does not use an extension (or file type), or 
the folder name includes an extension (or period).

Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.

Ö In Preview,  indicates that there is a conflict between the files and folders. To resolve the conflict, click the file or folder 
pair, and then click 

    on the toolbar.

Ö By default, each conflict is presented for you to resolve when you run an agent. To have Xchange Agent resolve conflicts 
automatically, click Properties on the File menu.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Resolve LFN Conflict dialog box

Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.

Ö In Preview,  indicates that you are attempting to transfer long file names to a drive or computer that accepts short file 
names only. To resolve the conflict, click the file or folder pair, and then click 

    on the toolbar.
Ö By default, each conflict is presented for you to resolve when you run an agent. To have Xchange Agent resolve conflicts 
automatically, click Properties on the File menu.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Next Conflict command

Ö Press F3 to quickly select the next conflict.

Ö To quickly select the next conflict, while in Preview, right-click and then click Next Conflict.

Ö The status line, located at the bottom of the Preview window, tells you how many conflicts have been identified.



Tips for Skip Pair(s) command

Ö To quickly set the selected folder pairs to be skipped, while in Preview, right-click and then click Skip Pair(s).

Ö To put skipped pairs back into a synchronization, select the skipped pair and then click        on the toolbar.
Ö You can skip more than one pair at a time. To skip all folder pairs, first click Select All in the Edit menu. To select two or 
more of the folder pairs, press Ctrl while you click each folder pair.
Ö Run the agent before closing a preview; otherwise any resolved conflicts or skips that you made will be lost.



Tips for Undo Skip Pair(s) command

Ö Press Ctrl+Z to quickly set the selected folder pairs to not be skipped.

Ö To quickly set the selected folder pairs to no longer be skipped, while in Preview, right-click and then click Undo Skip Pair(s).

Ö You must first select the file or folder pair that you want to undo.

Ö You can undo skip more than one pair at a time. To undo skipping all folder pairs, first click Select All in the Edit menu. To 
select two or more of the folder pairs, press Ctrl while you click each folder pair.



Tips for Close Preview command

Ö Once you have resolved conflicts or marked pairs to be skipped, run the agent before closing the preview. Otherwise, 
settings for skipping files or resolving conflicts will be lost.



Tips for Properties for New Agents command

Ö To override these settings for a particular Xchange agent, open the agent and then click Properties on the File menu.

Ö These File Transfer settings, which are found in the File Transfer Options dialog box, also apply to an Xchange agent: Enable 
File Transfer Recovery on the Copy/Move tab, Use Compression on the Performance tab, and Use SpeedSync on the 
Performance tab.

Ö By default, new and old (previously skipped) conflicts are handled the same way. To change how old conflicts are handled, 
click the Advanced tab.

Ö For Help on an item, click        at the top of the dialog box, and then click the item.



Tips for Toolbar command

Ö Hide the Xchange Agent toolbar when screen space is limited, such as on a laptop.

Ö The buttons on the toolbar give quick access to commands located in various menus. If you hide the toolbar, you can still 
access all commands through the menus or some commands by right-clicking a selection.



Tips for Status Line command

Ö Hide the Xchange Agent status line when screen space is limited, such as on a laptop.

Ö To view all of the information available in the status line, you may have to resize the Xchange Agent window.





Glossary of terms

The following are terms used in the LapLink for Windows online help and user’s guide. Click a word to see its 
definition.

A

Add Folder Pair button

B

C

Close Preview button (Xchange Agent)

Conflict

D

E

Edit mode (Xchange Agent)

F

Filter (Xchange Agent)

G

H

Hidden file

I, J, K

L

Left to Right Only button (Xchange Agent)

Local transfer

M



N

New Xchange Agent button (Xchange Agent)

Next Conflict button (Xchange Agent)

O

Open Xchange Agent button (Xchange Agent)

P

Preview mode (Xchange Agent)

Preview Xchange Agent button

Protected file

Q

R

Resolve Conflict button (Xchange Agent)

Right to Left Only button (Xchange Agent)

Run Xchange Agent button

S

Save Xchange Agent button

Skip Pair(s) button (Xchange Agent)

Source

Status line (Xchange Agent)

Synchronize Both Directions button (Xchange Agent)

System file

T

Toolbar (Xchange Agent)

U

Undo Skip Pair(s) button (Xchange Agent)

V, W

X

Xchange Agent menus

Y, Z






